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Measurement Resources

The measurement resources supported by Keysight B1500 series are shown below. For
reading this manual, ignore the information about the unsupported resources.

Resource B1500A B1505A B1506A B1507A
HPSMU Yes Yes

MPSMU Yes Yes Yes (B1511B) Yes (B1511B)
MCSMU Yes Yes Yes

MFCMU Yes Yes Yes Yes
HRSMU Yes
HVSPGU Yes

HVSMU Yes Yes (B1513C) Yes (B1513C)
HVMCU Yes

HCSMU Yes Yes for H20/H21

UHCU Yes Yes for H50/H51/H70/H71

UHVU Yes

HPSMU High power source/monitor unit (B1510A)

MPSMU Medium power source/monitor unit (81511A/B)

MCSMU Medium current source/monitor unit (B1514A)

MFCMU or CMU Multi frequency capacitance measurement unit (B15204)
HRSMU High resolution source/monitor unit (B1517A)

HVSPGU or SPGU High voltage semiconductor pulse generator unit (B1525A)
HVSMU High voltage source/monitor unit (B1513A/B/C)

HVMCU High voltage medium current unit (N1266A with one B1513A/B/C and two
B1514A/B1512A)

HCSMU High current source/monitor unit (B1512A)
UHCU Ultra high current unit (N1265A with two B1514A/B1512A)
UHVU Ultra high voltage unit (N1268A with two B1514A/B1512A)




FasyEXPERT Software

The EasyEXPERT software is installed in the Keysight B1500 for the measurement
execution and the measurement data analysis. And you can use the EasyEXPERT for an
external PC and that provides the following additional advantages to the B1500, allowing
you to minimize the amount of offline tasks performed on the B1500 and increase the
working ratio for measurements.

Allows the B1500, B2900, 4155, 4156, E5260, or E5270 to be controlled from an
external computer while online.

Allows test setup to be created on an external computer while offline.

Allows data analysis to be performed on an external computer while offline.
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Keysight B1500 Data server
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=1 To control B1500
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HUB Data server
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Note: The B1500 cannot be controlled via LAN.

For the information on installation of EasyEXPERT to the external PC, see “Using
EasyEXPERT on External PC” on page 7-1.




In This Manual

This manual describes the reference information of Keysight Technologies EasyEXPERT
which is the system software of Keysight Technologies precision current-voltage analyzer
series. This manual covers the following topics.

6. "Remote Control Interface"

Explains about the EasyEXPERT remote control interface which is a command set used
to control EasyEXPERT by a program.

7. "Using EasyEXPERT on External PC"

Explains how to run EasyEXPERT on an external PC.
8. "Utilities"

Introduces the utility programs.
9. "Application Library"

Lists the furnished application tests. Also describes the maximum measurement value
and accuracy for the result data measured by using the QSCV[2] application test.

10. "If You Have a Problem"

Introduces how to solve a problem you may encounter. Also describes how to perform
the system recovery and the data backup/recovery.

11. "Error Message"

Lists error codes and error messages.
A."Appendix"

Shows useful reference information for the use of the EasyEXPERT.
User’s Guide Vol. 1 consists of the following chapters.

“Main GUI”
“Classic Test Definition”

1
2
3. “Application Test Definition”
4. “Function Details”

5

“Built-in Programming Tool”




NOTE To get the latest firmware/software/manual/specifications/support information, go to
http://www.keysight.com/find/easyexpert.

NOTE The information is subject to change without notice due to the future enhancement. The
actual screen image of EasyEXPERT may be different from the image shown in this manual.
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NOTE

NOTE

NOTE

Remote Control Interface

This chapter explains about the EasyEXPERT remote control interface which is a
command set used to control EasyEXPERT by using a program via LAN, and
consists of the following sections.

*  “Introduction”

* “Notational Convention and Command Summary”
*  “Common Commands”

*  “BENCh Subsystem”

* “CALibration Subsystem”

*  “RESult Subsystem”

*  “STANDby Subsystem”

*  “SYSTem Subsystem”

*  “WORKSspace Subsystem”

e “Error Messages”

The following conventions are used in this chapter.

»  For Windows 7/8.1/10 64 bit version
<program folder>: <system drive>:\Program Files (x86)
e For Windows XP, Vista, 7/8.1/10 32 bit version
<program folder>: <system drive>:\Program Files

<system drive>: Drive the EasyEXPERT has been installed

Sample programs

Sample programs for using the EasyEXPERT remote control interface are stored in
the following folder. See the program code for your reference of programming.

<program folder>\Agilent\B1500\EasyEXPERT\Samples\Remote Control

About socket services

Keysight instruments are standardized on using port 5025 for socket services. A data
socket on this port can be used to send and receive commands, queries, and query
responses. All commands must be terminated with a newline for the message to be
parsed. All query responses will also be terminated with a newline.

6-2 Keysight EasyEXPERT User’s Guide Vol. 2, Edition 5



Remote Control Interface
Introduction

Introduction

The EasyEXPERT remote control interface is a software interface usable from the
VISA/SICL library. And it is used for the following applications as examples via
LAN using the socket service. See Figure 6-1.

* To control EasyEXPERT by using a program which runs on an external
computer (Controller A)

* To control EasyEXPERT by using a program which runs on the B1500

* To control EasyEXPERT which runs on a computer (Controller B) by using a
program on Controller A

* To control EasyEXPERT on Controller B by using a program on Controller B

Figure 6-1 Image of EasyEXPERT Remote Control

To control
EasyEXPERT group+ software

To control EasyEXPERT
by a program on Controller B

by a program on B1500

Controller B

- Controller A
Keysight B1500/EasyEXPERT installed with EasyEXPERT

To control
EasyEXPERT group+ software
via LAN from Controller A

To control EasyEXPERT
HUB  via LAN from Controller A
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Remote Control Interface
Introduction

Supported Operations

The EasyEXPERT remote control interface provides the subsystem commands
listed below. Operations supported by these commands are shown in Figure 6-2.

WORKSspace Subsystem
Opening/closing workspace
BENCh Subsystem

Performing test setup and measurement
RESult Subsystem

Getting test result data
CALibration Subsystem

Using offset current cancel function
STANDby Subsystem

Using standby function

SYSTem Subsystem

Checking errors

To start remote control, the workspace selection screen must be displayed by
EasyEXPERT.

6-4
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Figure 6-2

[ Power ON

Start EasyEXPERT

Operations supported by
EasyEXPERT remote
control interface

______ —_— = =

—)[ To open workspace

>

To change test parameters
(for Application Test)

|

|
To set test setup |
|

To execute measurement
(Single execution)

To get test results

_[

—[ To close workspace

— — ——/ \ ), — —

A 4
[ Exit EasyEXPERT

Preparation for Communication

Remote Control Interface
Introduction

Operations Supported by EasyEXPERT Remote Control Interface

](.

:‘WORK:OPEN

:BENC:PRES:SET:SEL
:BENC:APP:SEL

:BENC:SEL:NUMB
:BENC:SEL:STR

:BENC:SEL:RUN

:RES:FET

:WORK:CLOS

Communication between a computer and EasyEXPERT can be made as follows.

Confirm the firewall of Windows for the communication between the computer
and EasyEXPERT is set appropriately. See “Checking Windows Firewall

Setting”.

Prepare a computer installed with VISA/SICL library. They are included in
Keysight 10 Libraries Suite.

Connect the computer to a LAN. And connect the B1500, or the computer
installed with EasyEXPERT, to the same LAN. See Figure 6-1 for example.

Make a communication between the computer and EasyEXPERT using the
socket service. Only one EasyEXPERT can be connected.

If you use Keysight IO Libraries Suite, launch the Connection Expert software
and click the Add Instrument button to find and connect EasyEXPERT.

Keysight EasyEXPERT User’s Guide Vol. 2, Edition 5
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Remote Control Interface
Introduction

Checking Windows Firewall Setting

Click [Control Panel] > [System and Security] > [All a program through Windows
Firewall]. Allowed programs are listed on the screen. Make sure that the
EasyEXPERT is allowed.

If the list does not have the EasyEXPERT, allow it as follows:

1. As the administrator privileges, click the Change settings button.
2. Click the Allow another program... button.
A dialog box opens.

3. Click the Browse... button, and specify the path of the EasyEXPERT execution
file.

The EasyEXPERT is added to the program list in the dialog box.
4. Click EasyEXPERT in the program list, and then click the Add button.
The EasyEXPERT is added to the list of the “Allowed programs and features”.

5. Click the check box of the EasyEXPERT with setting the properties, and then
click the OK button.

6-6 Keysight EasyEXPERT User’s Guide Vol. 2, Edition 5
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Notational Convention and Command Summary

Notational Convention and Command Summary

Table 6-1 Notational Convention

Notation

Description

Capital letters

Capital letters are the minimally required letters of the
command or query program header. Lowercase letters are the
long form (complete spelling), which you can omit if desired.

Vertical bar |

Vertical bars separate alternative parameters. For example,
ONJOFF indicates that either “ON” or “OFF” can be used as a
parameter.

Square
brackets [ ]

Items within square brackets are optional. The representation
[:BENCh]:APPlication:SELect means that :BENCh may be
omitted.

NR1

Digits with an implied decimal point assumed at the right of the
least-significant digit. Example: 273

NR2

Digits with an explicit decimal point. Example: 27.3

NR3

Digits with an explicit decimal point and an exponent.
Example: 2.73E+02

NRf

Extended format that includes NR1, NR2, and NR3. Examples:
273,27.3, 2.73E+02

Bool

Boolean data. Can be numeric (0, 1), or named (OFF, ON).

SPD

String program data. Programs string parameters enclosed in
single or double quotes.

CPD

Character program data. Programs discrete parameters.
Accepts both short form and long form.

SRD

String Query response data. Returns string parameters enclosed
in single or double quotes.

Keysight EasyEXPERT User’s Guide Vol. 2, Edition 5 6-7
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Notational Convention and Command Summary

Notation Description

CRD Character Query response data. Returns discrete parameters.
Only the short form of the parameter is returned.

AARD Arbitrary ASCII Query response data. Permits the return of
un-delimited 7-bit ASCII. This data type has an implied
message terminator.

Block Definite length arbitrary binary data
Table 6-2 Subsystem Command Summary
Command Summary
WORKSspace subsystem
:WORKspace:CATalog? Returns catalog of your own workspace and the
Public workspace.
:WORKspace:CLOSe Closes the workspace now opened.
:WORKspace:OPEN "name" Opens the specified workspace.
name=Workspace name
:WORKspace [ : SELected] : NAME? Returns the name of the workspace now opened.
:WORKspace:STATe? Returns the status of the workspace.
BENCHh subsystem
[:BENCh] :APPlication:CATalog? Returns catalog of the application test definitions.
[:BENCh] :APPlication:SELect "name" Opens the specified application test definition.
name=Name of an application test definition
[ :BENCh] : COUNt count Sets or returns the value of the Count field.
[:BENCh] : COUNE? count=Value of the Count field
[ :BENCh] : COUNt :RESet Clears the value of the Count field.
[:BENCh] : LOAD[ : SETup] setup Loads and sets the test setup information included
in the XTS or XTR data.
setup=Test setup information, Block data

6-8 Keysight EasyEXPERT User’s Guide Vol. 2, Edition 5
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Command

Summary

[ :BENCh] : PRESet :CATalog?

Returns catalog of the preset group (My Favorite).

[ :BENCh] : PRESet :OPEN "name"

Opens the specified preset group (My Favorites).

name=Preset group name

[:BENCh] : PRESet [SELected] : NAME?

Returns the name of the preset group (My
Favorites) now opened.

[:BENCh] : PRESet:SETup:CATalog?

Returns catalog of the test setup included in the
preset group (My Favorites) now opened.

[ :BENCh] : PRESet :SETup: SELect "name"

Opens the specified test setup included in the preset
group (My Favorites) now opened.

name=Test setup name

[ :BENCh] [ : SELected] : ABORt Aborts the single measurement now in progress.
[:BENCh] [ :SELected] : NAME "name" Sets or returns the value of the Setup Name field of
[ :BENCh] [ :SELected] :NAME? the test setup now opened.

name=Value of the Setup Name field
[:BENCh] [:SELected] : NUMBer Sets or returns the value of the specified numeric

"name", value

[ :BENCh] [ : SELected]

:NUMBer? "name"

parameter defined in the application test now
opened.

name=Parameter name
value=Value of the parameter

[:BENCh] [ :SELected]

:RUN[:SINGle]

Starts the single measurement of the test now
opened.

[:BENCh] [ :SELected]

"non

"name","value"

[ :BENCh] [ : SELected]

:STRing

:STRing? "name"

Sets or returns the value of the specified string
parameter defined in the application test now
opened.

name=Parameter name
value=Value of the parameter

[ :BENCh] : TAG "deviceid"

[ :BENCh] : TAG?

Sets or returns the value of the Device ID field.

deviceid=Value of the Device ID field

RESult subsystem

:RESult:FETch[:LATest]?

Returns the latest test result data.

Keysight EasyEXPERT User’s Guide Vol. 2, Edition 5 6-9
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Notational Convention and Command Summary

Command

Summary

:RESult:FETch[:LATest] :SIBLings?

Returns the latest test result data. For the
application test result, this command returns the
result data for all included tests.

:RESult:FORMat mode Sets or returns the output format of the test result
:RESult:FORMat? data.

mode=TEXT|XTR
:RESult:FORMat:ESCape mode Sets or returns the newline character type used in

:RESult:FORMat:ESCape?

the test result data.

mode=0|OFF|1|ON

:RESult:RECycle:ALL

Adds all test result data to the Delete group.

:RESult:RECycle[:LATest]

Adds the latest test result data to the Delete group.

STANDDby subsystem

:STANDby:STATe mode

: STANDby: STATe?

Sets or returns the SMU standby function ON/OFF
status.

mode=0|OFF|1|ON

SYSTem subsystem

:SYSTem:ERRor [ : NEXT] ?

Returns the top code and message in the error
queue.

CALibration subsystem

:CALibration[:SMU]:ZERO:FULLrange Sets or returns the full range measurement ON/OFF
"module", mode status for the specified SMU+ASU.
:CALibration[:SMU] : ZERO: FULLrange? module=Identifier of the SMU
"module" mode=0|OFF|1|ON
:CALibration[:SMU] : ZERO:MEASure [ : CURR | Starts the offset current measurement for the SMU
ent] set to the offset current cancel function ON. Or
:CALibration[:SMU] : ZERO:MEASure [:CURR | returns the offset current measurement data of the
ent]? "module" specified SMU.
module=Identifier of the SMU
:CALibration[:SMU] : ZERO:OFF:ALL Sets the all SMU to the offset current cancel
function OFF.
6-10 Keysight EasyEXPERT User’s Guide Vol. 2, Edition 5
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Command

Summary

:CALibration[:SMU] : ZERO[ : ON]
"modulel"[,"module2"[,..."module"]]

:CALibration[:SMU] :

ZERO[:ON]?

Sets the specified SMU to the offset current cancel
function ON. Or returns the identifier of the SMU
set to the offset current cancel function ON.

module=Identifier of the SMU to be set to the offset
current cancel function ON

:CALibration|:

SMU]

:ZERO[:ON] :ALL

Sets the all SMU to the offset current cancel
function ON.

:CALibration(:
"module", plc

:CALibration|:

SMU]

SMU]

:ZERO:PLC

:ZERO:PLC? "module"

Sets or returns the integration time used for the
offset current measurement of the specified SMU.

module=Identifier of the SMU
plc=1]2|5|10|16]25|50[100

:CALibration(:

SMU]

:ZERO:STATe?

Returns the present status of the offset current
cancel function ON/OFF.
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Syntax

Query response

Syntax

Query response

Remote Control Interface
Common Commands

Common Commands

Describes common commands provided by the EasyEXPERT remote control
interface.

*CLS

Clears the error queue.

*CLS

*IDN?

Returns the EasyEXPERT identification string which contains four
comma-separated fields.

*IDN?

Agilent Technologies,Agilent EasyEXPERT,hostname,revision <newline>
hostname Host name of the computer which EasyEXPERT is running
revision EasyEXPERT revision number

Data type is AARD.

*OPC?

Starts to monitor run state of the commands sent before this command, and returns 1
if the instrument completes all pending operations.

Other commands cannot be executed until 1 is returned.
*QPC?

1 <newline>

Data type is NR1.
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Syntax
Parameter

Example

Syntax

Parameter

Query response

Remote Control Interface
BENCh Subsystem

BENCh Subsystem

Describes BENCh subsystem commands used for test setup and measurement.

[:BENCh]:APPlication:CATalog?

Returns catalog of the application test definitions. Returns all application test
definitions regardless of the Category selection.

[:BENCh]:APPlication:CATalog?

"app def1"[,"app def2"[, ... "app def"]]<newline>
Data type is SRD.

:APP:CAT?

[:BENCh]:APPlication:SELect

Opens the specified application test definition.
[:BENCh]:APPlication:SELect "name"

name Name of an application test definition. Data type is SPD.

:APP:SEL "Bvcbo"

[:BENCh]:COUNt

Sets or returns the value of the Count field.

[:BENCh]:COUNt count
[:BENCh]:COUNt?

count Value of the Count field. Data type is NR1.

count<newline>

Data type is NR1.
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BENCh Subsystem

Example :COUN 100
:COUN?

[:BENCh]:COUNt:RESet
Clears the value of the Count field.
Syntax [:BENCh]:COUNt:RESet
Example :COUN:RES

[:BENCh]:LOAD[:SETup]

Loads and sets the test setup information included in the XTS or XTR data. If the
XTR data contains multiple setup information, only the first setup information is

loaded.
Syntax [:BENCh]:LOADI[:SETup] setup
Parameter setup Test setup information. Data type is Block.
Example :LOAD #32229876543210 ... 987654321098<newline>

In this example, #3222 is followed by 222-byte length binary data.

[:BENCh]:PRESet:CATalog?

Returns catalog of the preset group (My Favorite).
Syntax [:BENCh]:PRESet:CATalog?

Query response "presetl"[,"preset2"[, ... "preset"]||[<newline>

Data type is SRD.

Example :PRES:CAT?
[:BENCh]:PRESet:OPEN
Opens the specified preset group (My Favorites).

Syntax [:BENCh]:PRESet:OPEN "name"
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Example

Syntax
Parameter

Example

Remote Control Interface
BENCh Subsystem

name Preset group name. Data type is SPD.

:PRES:OPEN "BJT Tests"

[:BENCh]:PRESet[:SELected]:NAME?

Returns the name of the preset group (My Favorites) now opened.
[:BENCh]:PRESet[:SELected:NAME?

"name"<newline>

Data type is SRD.

:PRES:NAME?

[:BENCh]:PRESet:SETup:CATalog?

Returns catalog of the test setup included in the preset group (My Favorites) now
opened.

[:BENCh]:PRESet:SETup:CATalog?

"setup1"[,"setup2"[, ... "setup"]]<newline>

Data type is SRD.

:PRES:SET:CAT?

[:BENCh]:PRESet:SETup:SELect

Opens the specified test setup included in the preset group (My Favorites) now
opened.

[:BENCh]:PRESet:SETup:SELect "name"
name

Test setup name. Data type is SPD.

:PRES:SET:SEL "BC Diode Fwd"
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Syntax

Parameter

Query response

Example

Remote Control Interface
BENCh Subsystem

[:BENCh][:SELected]: ABORt

Aborts the single measurement now in progress.
[:BENCh][:SELected]:ABORt

:ABOR

[:BENCh]|[:SELected]:NAME

Sets or returns the value of the Setup Name field of the test setup now opened.

[:BENCh][:SELected]:NAME "name"
[:BENCh][:SELected:NAME?

name Value of the Setup Name field. Data type is SPD.

"name"<newline>

Data type is SRD.

:NAME "BC Diode Fwd (Device A)"
:NAME?

[:BENCh][:SELected]:NUMBer

Sets or returns the value of the specified numeric parameter defined in the
application test now opened.

[:BENCh][:SELected]:NUMBer "param_name", nvalue
[:BENCh][:SELected|:NUMBer? "param_name"

param_name Parameter name. Data type is SPD.
nvalue Value of the parameter. Data type is NRf.
nvalue<newline>

Data type is NRf.

:NUMB "VcStep", 0.1
:NUMB? "VcStep"
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Syntax

Parameter

Query response

Example

Remote Control Interface
BENCh Subsystem

[:BENCh]|[:SELected]:RUN|[:SINGle]

Starts the single measurement of the test now opened. Use the *OPC? command to
confirm the completion of the single measurement.

[:BENCh][:SELected]:RUN[:SINGle]
‘RUN

[:BENCh][:SELected]:STRing

Sets or returns the value of the specified string parameter defined in the application
test now opened.

[:BENCh][:SELected]:STRing "param_name", "svalue"
[:BENCh][:SELected]:STRing? "param_name"

param_name Parameter name. Data type is SPD.

svalue Value of the parameter. Data type is SPD.

"svalue"<newline>

Data type is SRD.

:STR "Base", "SMU1:HP"
:STR? "Base"
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BENCh Subsystem

[:BENCh]:TAG

Sets or returns the value of the Device ID field.

Syntax [:BENCh]:TAG "deviceid"
[:BENCh]:TAG?

Parameter deviceid Value of the Device ID field. Data type is SPD.

Query response "deviceid"<newline>

Data type is SRD.

Example :TAG "Device A"
' TAG?
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Query response
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Syntax
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Remote Control Interface
CALibration Subsystem

CALibration Subsystem

Describes CALibration subsystem commands used for the offset current cancel
function.

:CALibration[:SMU]:ZERO:FULLrange

Sets or returns the full range measurement ON/OFF status for the specified
SMU+ASU.

:CALibration[:SMU]:ZERO:FULLrange "module", mode
:CALibration[:SMU]:ZERO:FULLrange? "module"

module Identifier of the SMU. Data type is SPD.
mode Full range measurement ON or OFF, 0JOFF|1|ON. Data type is
Bool.

0 | OFF: Full range measurement OFF

1 | ON: Full range measurement ON

mode<newline>

0 (OFF) or 1 (ON) is returned. Data type is Bool.

:CAL:ZERO:FULL "SMU4:HR/AS", 1
:CAL:ZERO:FULL? "SMU4:HR/AS"

:CALibration[:SMU]|:ZERO:MEASure[:CURRent]|

Starts the offset current measurement for the SMU set to the offset current cancel
function ON. Or returns the offset current measurement data of the specified SMU.
Use the *OPC? command to confirm the completion of the measurement.

:CALibration[:SMU]:ZERO:MEA Sure[:CURRent]
:CALibration[:SMU]:ZERO:MEASure[:CURRent]? "module"

module Identifier of the SMU. Data type is SPD.
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Query response currentl[,current2[,current3[ current4]]]<newline>
Data type is NRf.
currentl: Offset current measurement data for the 1 nA range
current2: Offset current measurement data for the 100 pA range
current3: Offset current measurement data for the 10 pA range

current4: Offset current measurement data for the 1 pA range

Example :CAL:ZERO:MEAS
:CAL:ZERO:MEAS? "SMU4:HR/AS"

:CALibration[:SMU]:ZERO:OFF:ALL

Sets the all SMU to the offset current cancel function OFF.
Syntax :CALibration[:SMU]:ZERO:OFF:ALL
Example :CAL:ZERO:OFF:ALL

:CALibration[:SMU]:ZERO|[:ON]

Sets the specified SMU to the offset current cancel function ON. Or returns the
identifier of the SMU set to the offset current cancel function ON.

Syntax :CALibration[:SMU]:ZERO[:ON] "modulel"[,"module2"], ... "module"]]
:CALibration[:SMU]:ZERO[:ON]?

Parameter module Identifier of the SMU to be set to the offset current cancel
function ON. Data type is SPD.

Query response "modulel"[,"module2"[, ... "module"]]<newline>

Identifier of the SMU set to the offset current cancel function ON. Data type is SRD.

Example :CAL:ZERO "SMUI1:HP", "SMU2:MP", "SMU3:MP"
:CAL:ZERO?
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Query response
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Remote Control Interface
CALibration Subsystem

:CALibration[:SMU]:ZERO[:ON]:ALL
Sets the all SMU to the offset current cancel function ON.
:CALibration[:SMU]:ZERO[:ON]:ALL

:CAL:ZERO:ALL

:CALibration[:SMU]:ZERO:PLC

Sets or returns the integration time used for the offset current measurement of the
specified SMU.

:CALibration[:SMU]:ZERO:PLC "module", plc
:CALibration[:SMU]:ZERO:PLC? "module"

module Identifier of the SMU. Data type is SPD.

plc Integration time, 1]2|5]10]16]25/50/100. This is the number of
power line cycles (PLC). If the invalid value is specified, the
maximum allowable value less than the specified value is set
automatically. Data type is NR1

plc<newline>

Data type is NR1.

:CAL:ZERO:PLC "SMU4:HR/AS", 25

:CAL:ZERO:PLC? "SMU4:HR/AS"
:CALibration[:SMU]:ZERO:STATe?

Returns the present status of the offset current cancel function ON/OFF.
:CALibration[:SMU]:ZERO:STATe?

mode<newline>

0 (OFF) or 1 (ON) is returned. Data type is Bool.

:CAL:ZERO:STAT?
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RESult Subsystem

Describes RESult subsystem commands used for getting/deleting the test result data,
and so on.

:RESult:FETch[:LATest]?

Returns the latest test result data.
Syntax :RESult:FETch[:LATest]?

Query response data<newline>
Data type is Block.
Example: #32569876543210 ... 987654<newline>
In this example, #3256 is followed by 256-byte length binary data.

Example :RES:FET?

:RESult:FETch[:LATest]:SIBLings?

Returns the latest test result data. For the application test result, this command
returns the result data for all included tests.

Syntax :RESult:FETch[:LATest]:SIBLings?

Query response data<newline>
Data type is Block.
Example: #39639876543210 ... 9876543210987<newline>
In this example, #3963 is followed by 963-byte length binary data.

Example :RES:FET:SIBL?
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RESult Subsystem

:RESult:FORMat

Sets or returns the output format of the test result data.

:RESult:FORMat mode
:RESult:FORMat?

mode Output format, TEXT|XTR. Data type is CPD.
TEXT: Text format, initial setting
XTR: EasyEXPERT test result data format

mode<newline>

TEXT or XTR is returned. Data type is CRD.

:RES:FORM XTR
:RES:FORM?

:RESult:FORMat:ESCape

Sets or returns the newline character type used in the test result data.

:RESult:FORMat:ESCape mode
:RESult:FORMat:ESCape?

mode Type, 0|OFF|1|ON. Data type is Bool.
0 | OFF: ASCII code 0x0D (CR) and 0x0A (LF), initial setting
1| ON: \r (CR) and \n (LF)

mode<newline>

0 (OFF) or 1 (ON) is returned. Data type is Bool.

:RES:FORM:ESC ON
:RES:FORM:ESC?
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:RESult:RECycle:ALL

Adds all test result data to the Delete group.
Syntax :RESult:RECycle:ALL

Example :RES:REC:ALL

:RESult:RECycle[:LATest]

Adds the latest test result data to the Delete group. For the application test result, the
result data for all included tests is subject.

Syntax :RESult:RECycle[:LATest]

Example :RES:REC
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STANDby Subsystem

STANDby Subsystem

Describes STANDby subsystem command used for the standby function.

:STANDDby:STATe
Sets or returns the SMU standby function ON/OFF status.

:STANDby:STATe mode
:STANDby:STATe?

mode Standby function ON or OFF, 0JOFF|1|ON. Data type is Bool.
0 | OFF: Standby function OFF
1 | ON: Standby function ON

mode<newline>

0 (OFF) or 1 (ON) is returned. Data type is Bool.

:STAND:STAT ON
:STAND:STAT?
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SYSTem Subsystem

Describes SYSTem subsystem command provided by the EasyEXPERT remote
control interface.

:SYSTem:ERRor[:NEXT]?

Reads and removes the top item in the error queue, and returns the top code and
message.

Syntax :SYSTem:ERRor[:NEXT]?

Query response response<newline>
response: code,"message"
code: Error code. Data type is NR1.
message: Error message. Data type is SRD.

Multiple responses are listed in the FIFO (first-in-first-out) order, separated by a
comma.

If the queue is empty, the response is +0,"No error".

Example :SYST:ERR?
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WORKSspace Subsystem

Describes WORKSspace subsystem commands used for opening/closing workspace,
and so on.

:WORKSspace:CATalog?

Returns catalog of your own workspace and the Public workspace.
:-WORKspace:CATalog?

"workspacel"[,"workspace2"|, ... "workspace"]|<newline>

Data type is SRD.
:WORK:CAT?

:WORKSspace:CLOSe

Closes the workspace now opened. Use the *OPC? command to confirm the
completion of close operation.

:WORKspace:CLOSe

:WORK:CLOS

:WORKSspace:OPEN

Opens the specified workspace. Use the *OPC? command to confirm the
completion of open operation.

:WORKspace:OPEN "name"
name Workspace name. Data type is SPD.

:WORK:OPEN "my workspacel"
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:WORKSspace[:SELected]:NAME?

Returns the name of the workspace now opened.
Syntax :-WORKSspace[:SELected]:NAME?

Query response "name"<newline>

Data type is SRD.

Example :‘WORK:NAME?

:WORKSspace:STATe?

Returns the status of the workspace.
Syntax :WORKSspace:STATe?

Query response status<newline>
OPEN or CLOS is returned. Data type is CRD.
OPEN: Workspace is now opened.

CLOS: Workspace is now closed. Or open/close operation is in progress.

Example :WORK:STAT?
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Error Messages

No Error

EasyEXPERT Error;Message ID:code / message

Error occurs in EasyEXPERT remote operation. code and message are as follows.
* code: Error code sent by EasyEXPERT

* message: Error message sent by EasyEXPERT

See “Keysight EasyEXPERT Operation Error” on page 11-3.

Remote Control Error;message

Error occurs in EasyEXPERT remote control library. message is as follows.

e Application Test definition does not exist; name: 4
* Exporting as Text Format failed.
Could not convert the test result data to the text format.
e Expression is not a resource; expression: 4
e Expression is not numeric; expression: 4
* Parameter is not numeric; Parameter: 4
e Preset Group does not exist; Preset Group: 4
e Parameter does not exist; parameter name: 4
e Test i1s being executed.
Measurement is now in progress.

* Test Setup does not exist in My Favorite; Test setup
name: A

Test setup 4 is not found in the preset group (My Favorite) now opened.
e There is no test result.
e SMU is not found; name: 4
* Smu Zero Cancel function is not supported.

Offset current cancel function is not supported.
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* Working setup is empty.
Test setup has not been selected.

* Working test setup is not an Application Test.
This test setup is not application test setup.

* Workspace does not exist; workspace name: 4

* Workspace is already open. Close before opening
workspace.

* Workspace is not ready.

e There is no workspace.
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NOTE

Using EasyEXPERT on External PC

This chapter explains how to run EasyEXPERT on an external PC.

System Requirements

To Install EasyEXPERT in External PC

Before Starting EasyEXPERT

To Start EasyEXPERT on Your PC

To Change Execution Mode and GPIB Settings
Using 4155B/4156B/4155C/4156C

Using E5260A/E5262A/ES5263A/ES5270B
Using B2900

About privilege to use EasyEXPERT

The revision 3.2 or later does not require the administrator privilege. However, if the
software is updated from a previous revision to the revision 3.2 or later, it still
requires the administrator privilege.

7-2 Keysight EasyEXPERT User’s Guide Vol. 2, Edition 5



Using EasyEXPERT on External PC
System Requirements

System Requirements

Table 7-1 shows the minimum requirements to run the EasyEXPERT software.

They are effective as of March 2019. For the latest information, go to
www.keysight.com/find/easyexpert.

Table 7-1 System Requirements

Overatin Microsoft Windows | Microsoft Windows | Microsoft Microsoft Windows

s Is) tem ar;gd Vista Business SP2 | 7 Professional SP1 | Windows 8.1 10 Pro or later

s}e]rvice ack | °F later (32 bit) or later (32 bit/64 Professional or (32Dbit/64bit)

P bit) later (32 bit/64 bit)

Processor Vista certified PC Windows 7 Windows 8.1 Windows 10
certified PC certified PC certified PC

Language English (US)

Memory 2 GB

Display XGA 1024x768 (SXGA 1280x1024 recommended)

Storage 1 GB free space on the C drive, 30 GB free space on a drive for test setup/result data

storage is recommended.

.NET Microsoft .NET Framework 3.5 SP1

Framework

10 Keysight IO Libraries Suite 16.2, 16.3, 17.1 update 1 or later (for | Keysight IO

Libraries the Online execution mode) Libraries Suite 17.1

update 1 or later
(for the Online
execution mode)
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Recommended GPIB Interface

For the GPIB connection of the instrument, use an GPIB interface, Keysight
82350B/C (for PCI bus), Keysight 82351A/B (for PCle bus), Keysight 82357A/B
(USB/GPIB), or National Instrument GPIB-USB-HS. See Table 7-2.

Table 7-2 Recommended GPIB Interface

B2901A/B
E5270B | B2902A/B
E5260A | B2901BL | 4155B/C
E5262A | B2911A/B | 4156B/C
E5263A | B2912A/B

Interface | B1500A

B2910BL
Keysight 82350B/C PCI YES 2 YES YES YES
82351A/B PCle YES 2 YES YES YES
82357A/B USB YES P YES YES b ¢ YES
National GPIB-USB-HS | USB YES P YES YES b-¢
Instruments

a. A PCI or PCle card is highly recommended because of stability and speed.

b. USB GPIB interfaces might cause serial poll error intermittently due to the intrinsic
communication scheme differences. It is reported that using an even GPIB address
sometimes significantly decreases the chance of the error. The NI GPIB-USB-HS is
recommended for stability, and the Keysight 82357A/B is recommended for speed.

c. EasyEXPERT software prohibits to set the odd GPIB address to prevent the issue
above. If using an odd GPIB address for Keysight 82357A/B, the address is detected
and an error occurs when starting up. For NI GPIB-USB-HS, note that an odd address
is not checked when starting up.
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NET Framework

As shown in Table 7-1, the Microsoft .NET 3.5 Framework SP1 is required for the
EasyEXPERT software.

Before installing the EasyEXPERT software, make sure that the Microsoft NET
Framework is installed and activated. On Windows 8.1 or later, it is not installed as
default. Follow the procedure below if it is not installed.

+ Installation through Internet:

1. Click [Control Panel] > [Programs] > [Turn Windows features on or off].
2. Check the “Net 3.5 framework” box, and then click “OK”.
3. Reboot the PC.

* Installation by using the Microsoft Windows DVD:

1. Insert the media to the DVD drive.
2. Go to the below folder:
E:\sources\sxs (in the case DVD drive is set to “E” drive)
3. As the administrator, open the “Command Prompt” window.

4. From the “Command Prompt” window, type in the following command and
press the Enter key.

Dism.exe /online /enable-feature /featurename:NetFX3 /All
/Source:E:\sources\sxs /LimitAccess

IO Library

As shown in Table 7-1, the Keysight IO Libraries Suite is required for the
EasyEXPERT software. You can download a proper version of the 10 Libraries
Suite from the Keysight website (http:\\www.keysight.com\).
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To Install EasyEXPERT in External PC

To Install EasyEXPERT in External PC

Prepare the EasyEXPERT software installation package.

Prepare a computer which satisfies the system requirements shown in Table 7-1.
For the accurate information for each revision, see README file included in the
installation package.

If you install the EasyEXPERT revision 5.5 or later, prepare the license file for
EasyEXPERT.

If you do not have the license file, prepare the Software Entitlement Certificate
sheet provided with the option SWS. And get the license file as described in this
sheet.

Install the EasyEXPERT software in your external PC by following the
procedure described in the README file.

To set the same module configuration as B1500

The module configuration of the B1500 can be set to the EasyEXPERT in the offline
mode. Copy the following file on the B1500 internal solid state drive (SSD) to the
<user configuration folder> on the PC which the EasyEXPERT runs.

For B1500A: <offline configuration folder>\UnitConfigB1500A.xml

For B1505A: <offline configuration folder>\UnitConfigB1505A.xml
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Before Starting EasyEXPERT

Note the following when you use EasyEXPERT on your PC.

*  When using the Offline mode, use the data import/export function to transfer
your test setup data files and test result records.

*  When using the Online mode, do not send a control command to the instrument
(B1500A, B1505A or other supported model) by using a programming
environment except for EasyEXPERT.

* Do not send a control command to the analyzer by using the GPIB IO statement
in the application test definitions.

* To control the B1500 from the external PC, exit EasyEXPERT on the B1500.
The Start EasyEXPERT window (button) must be displayed or be minimized to
the Windows task bar on the B1500 screen.
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To Start EasyEXPERT on Your PC

To launch EasyEXPERT on your PC, follow the procedure below.
1. Click Start > All Programs > Keysight EasyEXPERT > EasyEXPERT.

2. Ifthe Execution Mode dialog box is not opened, click Option > Execution Mode
on the Start EasyEXPERT window.

3. On the Execution Mode dialog box, select the execution mode, Online or
Offline. If you select the Online mode, set the GPIB configuration. See
EasyEXPERT User’s Guide Vol.1 for more detail on the Execution Mode dialog
box.

4. Click the OK button on the Execution Mode dialog box.
5. Click the Start EasyEXPERT button to launch EasyEXPERT.
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To Change Execution Mode and GPIB Settings

To change the EasyEXPERT execution mode or the GPIB configuration, follow the
procedure below.

1. Launch Start EasyEXPERT.

If the Execution Mode dialog box is not opened, click Option > Execution Mode
on the Start EasyEXPERT window.

If EasyEXPERT is running, exit it. And click Option > Execution Mode on the
Start EasyEXPERT window.

2. Select the execution mode, Online or Offline.

If you select the Online mode, set the GPIB configuration. See EasyEXPERT
User’s Guide Vol.1 for more detail on the Execution Mode dialog box.

3. Click the OK button to set the changes.

Click the Cancel button to cancel the setup changes.
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Firmware Revision

4155/4156
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Using EasyEXPERT on External PC
Using 4155B/4156B/4155C/4156C

Using 4155B/4156B/4155C/4156C

This section describes the notices for controlling the 4155/4156.

4155/4156 firmware revision supported by the EasyEXPERT

¢ HOSTC: 03.08 or later
e SMUC: 04.08 or later

4155/4156 functions unsupported by the EasyEXPERT

* Log sampling measurement and Thinned out sampling measurement
* Functions using R Box

» Differential voltage measurement using VMU (Voltage Monitor Unit)
* DC bias output using PGU (Pulse Generator Unit)

¢ Other functions unavailable for the B1500

Classic tests available for 4155/4156

* I/V Sweep, I/V-t Sampling, and Switching Matrix Control for 4155C/4156C
* I/V Sweep and Switching Matrix Control for 4155B/4156B
EasyEXPERT functions unavailable for 4155/4156

e Tracer Test

» Functions using SMU Series Resistor

* Functions using ASU (Atto Sense Unit)

* Functions using SCUU (SMU CMU Unify Unit)

* Functions using CMU (Capacitance Measurement Unit)

* Functions using SPGU (Semiconductor Pulse Generator Unit)

PGU can be used instead of SPGU for the I/V Sweep and I/V-t Sampling classic
tests. The Load Z function and the ALWG output are not supported. The Output
Impedance dialog box is available to set the output impedance of the PGU.

* Functions using WGFMU (Waveform Generator/Fast Measurement Unit) and
RSU (Remote-sense and Switch Unit)
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Calibration

Configuration,
Main Frame

Configuration,
Module

I/V Sweep

I/V-t Sampling

ADC and
Integration Time

Using EasyEXPERT on External PC
Using 4155B/4156B/4155C/4156C

Differences on Calibration window

* Calibration window provides Module Self Calibration screen only.

*  Module Self Calibration screen provides Enable Auto Calibration only.

Differences on Configuration window Main Frame screen
* Line Frequency just displays the setting of 4155/4156.
* Firmware Rev. displays as follows.

[HOSTC Rev.]:[SMUC Rev.]:[ADC Rev.]

* Main Frame Diagnosis is not supplied.

Differences on Configuration window Module screen

» Self-test cannot be performed.

» Status, SCUU, and Notes columns are not supplied.

o Start Self Test and Recover Module buttons are not supplied.

* Accessory Configuration is not supplied.

Differences on I/V Sweep Classic Test

* Time Stamp Name field is not supplied for 4155B/4156B.

*  Number of sweep steps must be 1 to 1001 for VARI.

*  SMU Pulse Period and Width value must satisfy Period > Width + 4 ms.

Differences on I/V-t Sampling Classic Test

* Log sampling is not supported.

e Sampling interval must be 60 ps to 65.535 s.
e Number of samples must be 1 to 10001.

¢ Base hold time must be 0 sec.

Differences on A/D Converter & Integration Time Setup
* ADC always shows HR ADC.
* High Resolution ADC is set as shown in Table 7-3.

Integration Time is ignored for the sampling measurement of Interval <2 ms.
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Advanced Setup

Table 7-3

NOTE

Using EasyEXPERT on External PC
Using 4155B/4156B/4155C/4156C

Differences on Advanced Setup

» Series R always shows NONE.

*  Wait Time Control is not supplied.

Setting of High Resolution ADC

Mode Factor Setting of 4155/4156

AUTO - MEDIUM

MANUAL 1< N < 127 | SHORT, TIME=80 us x N

PLC 1 MEDIUM

N22 LONG, NPLC=N

To reuse the test setup for BISO0A

Perform the following procedure to reuse the test setup created for the B1500A.

1. Launch EasyEXPERT with the condition Set Analyzer=B1500A.
2. Export the test setups to be reused. And exit EasyEXPERT.

3. Launch EasyEXPERT with the condition Set Analyzer=4155B, 4156B, 4155C,
or 4156C.

4. Import the test setups exported at the step 2.
5. Set the channel for the analyzer to use.

Also, the procedure made by replacing the step 1 with the step 3 can be used to reuse
the test setup created for the 4155/4156.
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E5260A/E5262A/E
5263A/E5270B
Firmware Revision

EasyEXPERT

Calibration

Configuration,
Main Frame

Configuration,
Module

Using EasyEXPERT on External PC
Using E5260A/E5262A/E5263A/E5270B

Using ES260A/E5262A/E5263A/ES5270B

This section describes the notices for controlling the
E5260A/E5262A/E5263A/E5270B.

Firmware revision supported by EasyEXPERT
* B.01.10 or later

Classic tests available for ES260A/ES5262A/E5263A/E5270B

* I/V Sweep, Multi Channel I/V Sweep, I/V List Sweep, and Switching Matrix
EasyEXPERT functions unavailable for ES260A/E5262A/E5263A/E5270B

e I/V-t Sampling

* Direct Control

» Tracer Test

*  Functions using SCUU (SMU CMU Unify Unit)

* Functions using CMU (Capacitance Measurement Unit)

* Functions using SPGU (Semiconductor Pulse Generator Unit)

*  Functions using WGFMU (Waveform Generator/Fast Measurement Unit) and

RSU (Remote-sense and Switch Unit)

Differences on Calibration window

* Calibration window provides Module Self Calibration screen only.

*  Module Self Calibration screen provides Enable Auto Calibration only.

Differences on Configuration window Main Frame screen

* Line Frequency just displays the setting of ES260A/E5262A/E5263A/E5270B.

* Main Frame Diagnosis is not supplied.

Differences on Configuration window Module screen

» Self-test cannot be performed.

» Status, SCUU, and Notes columns are not supplied.
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IIV Sweep

NOTE

Using EasyEXPERT on External PC
Using E5260A/E5262A/E5263A/E5270B

o Start Self Test and Recover Module buttons are not supplied.

* Accessory Configuration is not supplied.

Differences on I/V Sweep Classic Test

* Time Stamp Name field is not supplied for ES260A/E5262A/E5263A/E5270B.
*  Number of sweep steps must be 1 to 1001 for VARI.
* SMU Pulse Period and Width value must satisfy as:

* Period > Width + 2 ms. (for width < 100 ms)
* Period > Width + 10 ms. (for width > 100 ms)

To reuse the test setup for BIS00A

Perform the following procedure to reuse the test setup created for the B1500A.

1. Launch EasyEXPERT with the condition Set Analyzer=B1500A.
2. Export the test setups to be reused. And exit EasyEXPERT.

3. Launch EasyEXPERT with the condition Set Analyzer=E5260A, E5262A,
ES5263A, or ES270B.

4. Import the test setups exported at the step 2.
5. Set the channel for the analyzer to use.

Also, the procedure made by replacing the step 1 with the step 3 can be used to reuse
the test setup created for the ES260A/E5262A/E5263A/E5270B.
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NOTE

Using EasyEXPERT on External PC
Using B2900

Using B2900

This section describes the notices for controlling the B2900.

Using Multiple B2900 Units

To use the multiple B2900 units (maximum 4 units), each of the multiple B2900
units are connected together by using the N1294A opt.032 Digital I/O Trigger Cable
for Multiple Unit Control. This cable has one connector for a primary unit and three
connectors for secondary units. The connector for a primary unit is stacking
connector also for general use such as interlock connection. Use only one cable for
primary/secondary connections.

PC

1. Connect the Primary connector of —C% GPIB Cable

trigger cable to the Digital I/O Primary B2900
terminal of Primary B2900. =

2. Connect the Secondary connector of
trigger cable to the Digital I/O
terminal of Secondary B2900.

If the multiple secondary units are
configured, connect all secondary
units.

3. Connect all B2900 units to your PC
using GPIB cables.

4. Launch EasyEXPERT.

5. Select Options > Execution Mode...
on the Start EasyEXPERT window
to open the Execution Mode dialog
box, and set up VISA interface ID
of GPIB interface installed in your
computer and GPIB addresses on i .
multiple B2900 units. See Configuration

“Recommended GPIB Interface”. Examplg P
of 3 Units Digital I/0 Trigger Cable
for Multiple Unit Control
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NOTE

EasyEXPERT

Calibration

Configuration,
Main Frame

Using EasyEXPERT on External PC
Using B2900

Using B2901BL or B2910BL

Some of B2900 functions and ranges are not available for B2901BL/B2910BL. For
more information on the limitations, refer to the B2900B User’s Guide.

If you set a parameter that B2901BL/B2910BL does not support, an error message
will be displayed.

The following EasyEXPERT functions are available for B2900

* I/V Sweep, Multi Channel I/V Sweep, I/V List Sweep, I/V-t Sampling, and
Switching Matrix

¢ Tracer Test

EasyEXPERT functions unavailable for B2900

* Direct Control

* Functions using SCUU (SMU CMU Unify Unit)

* Functions using CMU (Capacitance Measurement Unit)

* Functions using SPGU (Semiconductor Pulse Generator Unit)

* Functions using WGFMU (Waveform Generator/Fast Measurement Unit) and
RSU (Remote-sense and Switch Unit)

Differences on Calibration window

» Calibration window provides Module Self Calibration screen only.
e Module Self Calibration screen does not provide Full Range Calibration and
Enable Auto Calibration.

Differences on Configuration window Main Frame screen

* If the multiple B2900 configuration, the information of primary B2900 is
displayed on Main Frame screen. The information of all B2900s are displayed at
the bottom of the window.

« Ifyou change the Line Frequency setting, the line frequency of all B2900s are
changed.

* The diagnosis function for the trigger cable is provided on B2900 Diagnosis.
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Using EasyEXPERT on External PC

Using B2900
Configuration, Differences on Configuration window Module screen
Modules
* SCUU is not supported but the SCUU column exists.
* Recover Module button is not supplied.
* Accessory Configuration is not supplied.
I/V Sweep, Differences on I/V Sweep and Multi-Channel Classic Test
Multi-Channel I/V
Sweep « Differences on Channel Definition
Function Description
Unit B2901A/B SMUn.B290X
B2902A/B
B2901BL
B2911A/B SMUn.B291X
B2912A/B
B2910BL
Mode V/I/VPULSE/IPULSE
Function VAR1/VAR2/CONST
» Differences on Measurement
Function Description
Linear/Log LINEAR/LOGI0
No. of Steps VARI1 1 to 2500
VAR2 1 to 1001
Power Compliance Unsupported
SMU Pulse: Base Supports DC region
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Using EasyEXPERT on External PC
Using B2900

Function

Description

SMU Pulse: Period

50 us to 100000 s

SMU Pulse: Width

50 ps t0 99999.9 s

Timing: Hold

0 to 100000 s

Timing: Delay

0 to 100000 s

If Pulse measurement, calculated as follows:
Delay = Pulse end time — Integration Time (minimum value:0)
If Integration Time: Mode is AUTO, Integration Time=2 ms

Sweep status

The output switch is OFF when the sweep is aborted.

A/D Converter
Integration Setup

A/D Converter

HS ADC only

Integration Time Setup

AUTO: 0.1 PLCor 1 PLC
MANUAL: 1 to 40000 (1 Factor=50 us)
PLC: 1to 100

Advanced Setup:
Channel Settings

Series R is unavailable

Low Terminal

Low terminal setting.

GROUNDED/FLOATING
High Cap. High capacitance mode setting.
ON/OFF
Advanced Setup: State ON/OFF
Wait Time Control
Factor 0 to 100
Advanced Setup: Output value after START/STOP

After Measurement
Settings

measurement
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IV List Sweep

I/V-t Sampling

Using EasyEXPERT on External PC
Using B2900

Differences on I/V List Classic Test.

Same as I/V Sweep Classic Test except the followings.

¢ Differences on Measurement

Function Description

List Length VARI1 1 to 1001

VAR2 1 to 1001

Differences on I/V-t Sampling Classic Test.

¢ Differences on Channel Definition

Function Description

Unit B2901A/B SMUn.B290X

B2902A/B

B2901BL

B2911A/B SMUn.B291X

B2912A/B

B2910BL

Mode V/1
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Using EasyEXPERT on External PC
Using B2900

¢ Differences on Measurement

Function Description
Linear/Log LINEAR only
Interval 10 us to 100000 s
If SMUn.B290X exists, the setting of 20 pus or below is set to 20 ps.
No. of Samples 1 to 100000 (Total of all measurement channels)
Hold Time 0 to 100000 s
Base Hold Time 0 to 100000 s
A/D Converter A/D Converter HS ADC only
Integration Setup ) )
Integration Time Setup AUTO: 0.1 PLCor 1 PLC
MANUAL: 1 to 40000 (1 Factor=50 us)
PLC: 1to 100
Advanced Setup: Series R is not available
Channel Settings - - -
Low Terminal Low terminal setting.
GROUNDED/FLOATING
High Cap. High capacitance mode setting. ON/OFF
Advanced Setup: State ON/OFF
Wait Time Control
Factor 0to 100
Advanced Setup: Output value after START only
After Measurement measurement
Settings
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Tracer Test

Using EasyEXPERT on External PC
Using B2900

Differences on Tracer Test

Function Description
VARI1 No. of Steps 1 to 2500
Power Comp. unsupported
Pulse Delay 05t099999.9 s
Pulse Width 50 ps to 100000 s
Hold Time 0 s to 100000 s
VAR2 No. of Steps 1 to 2500
Power Comp. unsupported
Hold Time 0 s to 100000 s
Meas. Delay 2 usto 4.99s
Meas. Time 8 us to 20 ms
Step Time 500 ustoS5s
Pulse Period Smsto5s

NOTE

To reuse the test setup for BIS00A

Perform the following procedure to reuse the test setup created for the B1500A.

1. Launch EasyEXPERT with the condition Set Analyzer=B1500A.
2. Export the test setups to be reused. And exit EasyEXPERT.

3. Launch EasyEXPERT with the condition Set Analyzer=B2901A, B2902A,
B2911A, B2912A, B2901B, B2902B, B2901BL, B2911B, B2912B, or
B2910BL.

4. Import the test setups exported at the step 2.
5. Set the channel for the analyzer to use.

Also, the procedure made by replacing the step 1 with the step 3 can be used to reuse
the test setup created for B2900.
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Using EasyEXPERT on External PC
Using B2900
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NOTE

Utilities

This chapter introduces the utility programs included in Keysight B1500 and
EasyEXPERT.

“System Requirement”
“License Management Tool”
“Setup File Converter”
“MDM File Converter”

“Utility Programs”

The following conventions are used in this chapter.

For Windows 7/8.1/10 64 bit version
<program folder>: <system drive>:\Program Files (x86)

<offline configuration folder>: <system drive>:\ProgramData\Agilent\EasyEXP
ERT\Service\OfflineConfiguration

<user configuration folder>: <system drive>:\Users\<your account>\AppData\R
oaming\Agilent\EasyEXPERT\Service\OfflineConfiguration

For Windows Vista, 7/8.1/10 32 bit version
<program folder>: <system drive>:\Program Files

<offline configuration folder>: <system drive>:\ProgramData\Agilent\EasyEXP
ERT\Service\OfflineConfiguration

<user configuration folder>: <system drive>:\Users\<your account>\AppData\R
oaming\Agilent\EasyEXPERT\Service\OfflineConfiguration

For Windows XP
<program folder>: <system drive>:\Program Files

<offline configuration folder>: <system drive>:\Documents and Settings\All
Users\Application Data\Agilent\EasyEXPERT\Service\OfflineConfiguration

<user configuration folder>: <system drive>:\Documents and Settings\All
Users\Application Data\Agilent\EasyEXPERT\Service\OfflineConfiguration

<system drive>: Drive the EasyEXPERT has been installed

<your account>: Your Windows login account
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Utilities

System Requirement

System Requirement

Table 8-1 shows the minimum requirements to run the EasyEXPERT software and
the programs furnished with the B1500. They are effective as of March 2019. For
the latest information, go to www.keysight.com/find/easyexpert.

Table 8-1 System Requirements

Overatin Microsoft Windows | Microsoft Windows | Microsoft Microsoft Windows

s Is) tem ar;gd Vista Business SP2 | 7 Professional SP1 | Windows 8.1 10 Pro or later

s}e]rvice ack | °F later (32 bit) or later (32 bit/64 Professional or (32Dbit/64bit)

P bit) later (32 bit/64 bit)

Processor Vista certified PC Windows 7 Windows 8.1 Windows 10
certified PC certified PC certified PC

Language English (US)

Memory 2 GB

Display XGA 1024x768 (SXGA 1280x1024 recommended)

Storage 1 GB free space on the C drive, 30 GB free space on a drive for test setup/result data

storage is recommended.

NET Microsoft .NET Framework 3.5 SP1

Framework

10 Keysight IO Libraries Suite 16.2, 16.3, 17.1 update 1 or later (for | Keysight IO

Libraries the Online execution mode) Libraries Suite 17.1

update 1 or later
(for the Online
execution mode)
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Utilities
License Management Tool

License Management Tool

The licence management tool is the program used to install the license of the
software listed below. This program is also used to confirm the licenses already
installed and the host ID of the B1500 or the computer for EasyEXPERT.

*  BI1500A-SWS EasyEXPERT Extension

* BI1500AU-SWS EasyEXPERT Extension
* BI1505A-SWS EasyEXPERT Extension

* BI1505AU-SWS EasyEXPERT Extension
*  BI1506A-SWS EasyEXPERT Extension

* BI1507A-SWS EasyEXPERT Extension

* B2901AU EasyEXPERT Extension

* B2902AU EasyEXPERT Extension

* B2911AU EasyEXPERT Extension

* B2912AU EasyEXPERT Extension

* B2901BU EasyEXPERT Extension

* B2902BU EasyEXPERT Extension

* B2901BLU EasyEXPERT Extension

* B2911BU EasyEXPERT Extension

* B2912BU EasyEXPERT Extension

* B2910BLU EasyEXPERT Extension

*  E5260A-SWS EasyEXPERT Extension

*  E5260AU-SWS EasyEXPERT Extension
* E5270B-SWS EasyEXPERT Extension

« E5270BU-SWS EasyEXPERT Extension

To launch program Click Start > All Programs > (Keysight EasyEXPERT >) Licence Management
Tool.
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To check licenses
already installed

To check host ID

To install license

File menu

Help menu
Install icon

Installed Licenses
tab screen

Information tab
screen

Utilities
License Management Tool

Click Installed Licenses tab on the Licence Management Tool. The installed
licenses will be displayed.

Click Information tab on the Licence Management Tool. The host ID of the B1500
or the computer will be displayed.

The following procedure installs the license.

1. Click Install icon, or click File > Install License File to open a dialog box.
2. Specify the license file (.lic file).
3. Click Open.

License Management Tool GUI

Install License File Opens a dialog box used to specify the license file.

Exit Closes the License Management Tool.
About Opens the About dialog box.
Opens a dialog box used to specify the license file.

Displays the license already installed.

Displays the host ID of the B1500 or the computer for EasyEXPERT.
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Execution
environment

To launch program

To create XTS file

To read XTS file

Utilities
Setup File Converter

Setup File Converter

The setup file converter is the program which converts the Keysight 4155A/4156A/
4155B/4156B/4155C/4156C setup file (extension: DAT or MES) and creates the
EasyEXPERT setup file (extension: XTS). This program can convert the setup
information but cannot convert the test result data.

EasyEXPERT execution environment

To execute this program, the SetupFileConverter.exe, SetupFileConverterW.exe,
and SetupFileConverterW.exe.config files must be stored in the following folder.

<program folder>\Agilent\B1500\EasyEXPERT\415xC\Conversion\

Click Start > All Programs > Agilent BIS00A EasyEXPERT > 4155,4156 Setup
File Converter.

The following procedure converts the 4155/4156 setup file (.DAT or .MES) and
creates the .XTS file in the folder the setup file is stored.

1. Click Select icon, or click File > Select Files to open the Select 4155/4156 MES
Files or DAT Files dialog box.

2. Specify the 4155/4156 setup file to convert. Multiple files can be selected.

3. Click Open on the Select 4155/4156 MES Files or DAT Files dialog box.

4. Click Convert icon, or click File > Convert Files.

Instead of the step 1 to 3, you can use the drag and drop operation from Explorer to
the Selected Files area on the Setup File Converter.

Use the import function to read the created .XTS file on the EasyEXPERT.

Open the Import Test Setup window by clicking File > Import Test Setup... on the
Classic Test screen. Specify the .XTS file to be imported, and click Open.

Conversion results For details about the conversion results, see “SetupFileConverter.exe” on page 8-24.
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File menu

Help menu

Icons

Create XTS for

Selected Files

Log

Utilities
Setup File Converter

Setup File Converter GUI

The setup file converter provides the following GUI.
Select Files Opens the Select 4155/4156 MES Files or DAT Files dialog box
used to specify the 4155/4156 setup files to convert.

Convert Files Performs conversion and creates XTS file. This program
overwrites the file of the same name.

Clear Clears the Selected Files area and the Log area.

Quit Closes the setup file converter.

About Opens the About dialog box.

Select Opens the Select 4155/4156 MES Files or DAT Files dialog box

used for specifying the 4155/4156 setup files to convert.

Convert Performs conversion and creates X TS file. This program
overwrites the file of the same name.

Clear Clears the Selected Files area and the Log area.

Specifies the type of the XTS file to create.
B1500A XTS file for the B1500
4155B/C XTS file for the 4155A/B/C

4155B/C with HPSMU XTS file for the 4155A/B/C. The HPSMU in the
MES/DAT file is converted to SMUS5: HP.

4156B/C XTS file for the 4156A/B/C

4156B/C with HPSMU XTS file for the 4155A/B/C. The HPSMU in the
MES/DAT file is converted to SMUS5: HP.

Lists the 4155/4156 setup files to convert. Drag and drop operation is allowed.

Displays the execution log.
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Supported data

Execution
environment

To launch program

To create MDM file

NOTE

Utilities
MDM File Converter

MDM File Converter

The MDM file converter is the program which converts the EasyEXPERT test result
data file (extension: xtr or ztr) and creates the Keysight IC-CAP model data
manager file (extension: mdm).

The MDM file converter supports the test result data of the following Classic Tests.

o I/V Sweep
e Multi Channel I/'V Sweep
*  C-V Sweep

The Application Test result data is not supported.

EasyEXPERT execution environment

To execute this program, the MdmFileConverter.exe and MdmFileConverterW.exe
files must be stored in the following folder.

<program folder>\Agilent\B1500\EasyEXPERT\IC-CAP Support\MDM\

Click Start > All Programs > Agilent BIS00A EasyEXPERT > IC-CAP MDM File
Converter.

The following procedure converts the xtr/ztr file and creates the mdm file with the
same name as the xtr/ztr file in the folder which the xtr/ztr file has been stored.

1. Click Browse... to open the Please select Test Result File dialog box.

2. Select the xtr/ztr file to convert. Multiple files can be selected.

3. Click Convert, or click Action > Convert.

Instead of the step 1 to 2, you can use the drag and drop operation from Explorer to

the Input Files area on the MDM file converter.

If a mdm file of the same name already exists, “(V)” is added to the file name. For
example, if the abc.mdm file already exists when converting the abc.xtr file, the
abc(1).mdm file is created.
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File menu

Action menu

Help menu

Input Files

Options

Log

Utilities
MDM File Converter

MDM File Converter GUI
The MDM file converter provides the following GUIL

Exit

Convert

About

Lists the xtr/ztr file.

Browse...

Remove

Convert

Cancel

Closes the MDM file converter.

Performs conversion of the files listed in Input Files and creates
mdm files.

Opens the About dialog box.

Opens the Please select Test Result File dialog box used for
selecting the xtr/ztr files to convert. The selected files are listed
in Input Files.

Removes the highlighted files from Input Files.

Performs conversion of the files listed in Input Files and creates
mdm files.

Cancels the file conversion.

The following optional functions are available.

* Append Test Setup Title to Mdm File Name

Check this box if you want to append the test setup title to the mdm file name. If
the xtr/ztr file name is “abc” and the test setup title is “title”, the mdm file name
will be “abc-title”.

* Specified Output Folder

Check this box if you want to specify the folder used for storing the mdm files
which are the conversion results. This enables the entry field and the Browse...
button. The folder can be specified by entering a folder name to this field
directly or by selecting a folder on the dialog box opened by clicking the
Browse... button.

Displays the execution log.
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To launch program

NOTE

Utilities
Utility Programs

Utility Programs

The following useful programs are stored in the following folder. Remember that
they are just sample programs.

<program folder>\Agilent\B1500\EasyEXPERT\Utilities\

*  “User Account Management Tool”

*  “Offline Configuration Tool”

*  “Software Configuration Tool”

*  “Prober Control”

o “sleep.exe”

« “XSLT”

<program folder>\Agilent\B1500\EasyEXPERT\415xC\Conversion\

*  “SetupFileConverter.exe”

<program folder>\Agilent\B1500\EasyEXPERT\IC-CAP Support\tMDM\

¢ “MdmFileConverter.exe”

User Account Management Tool

User Account Management Tool sets the passwords to the user level of the
EasyEXPERT and assigns the user level of the EasyEXPERT to the Windows
accounts.

Click Start > All Programs > Keysight EasyEXPERT > Tools > User Account
Management.

This program requires administrator privileges.

For details, see “User Level Setting” section in EasyEXPERT User s Guide Vol. 1.
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To launch program

File menu

Modules

Main Frame

Utilities
Utility Programs

Offline Configuration Tool

Offline Configuration Tool sets the configuration of B1500 or E5270B for the

offline mode.

Click Start > All Programs > Keysight EasyEXPERT > Tools > Offline

Configuration.

Offline Configuration Tool provides the following GUI.

New

Load

Import

Save
Export
Delete
Exit

Slot
Module Type

Name

Creates new offline configuration.

Loads the offline configuration file. You can select Common for
all user or User for personal.

Import the offline configuration from the exported offline
configuration file (Arbitrary file) or the instrument (from
Equipment).

Saves the current configuration to the file. You can select As
Common for all user or As User for personal use.

Exports the current configuration as the offline configuration
file with the specified name.

Deletes the configuration file.

Closes the Offline Configuration Tool.

Slot number
Selects the module in the corresponding slot.

Module name.

Shows the information of the mainframe.
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Utilities
Utility Programs

Software Configuration Tool

Software Configuration Tool sets the auto start programs at Windows startup.

To launch program Click Start > All Programs > Keysight EasyEXPERT > Tools > Software
Configuration.

NOTE This program requires administrator privileges.

Software Configuration Tool provides the following GUI.

File menu Exit Closes Software Configuration Tool.
Edit menu Cancel all Clears all programs in the Startup Programs.
Reset to the

factory default  Resets to the setting at factory shipment.

Startup The programs listed the Startup Programs will automatically start at Windows
startup.

1. Selects the program to auto start from the Programs.
2. Click the right-arrow to move the selected program to the Startup Programs.

3. To delete the program in the Startup Programs, select it and click Delete button.
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Utilities
Utility Programs

Prober Control

The <program folder>\Agilent\B1500\EasyEXPERT\Utilities\ProberControl folder
stores the execution files used to control the following probers.

e (Cascade Microtech Summit 12000/S300 (Nucleus)
* Cascade Microtech (Suss MicroTec) PA200 or PA300
*  Vector Semiconductor VX-2000 or VX-3000

You can use the execution files when you perform a repeat measurement by using
EasyEXPERT and a prober listed above. The execution files control the prober
chuck movement (down, move, and up) by defining them in the Repeat
Measurement Setup window. See “Remote Measurement Setup” in Chapter 1,
User’s Guide Vol. 1.

This folder also stores the source files and the document files. See the pdf files in the
ProberControl\xxxx\doc folder for more details or if you create your own prober
control script by referring to the source code; xxxx is cascade, suss, or vector.

And also, the prober information file “prober info.ini” is stored in the
<AllUsersProfile>\Agilent\EasyEXPERT\Utilities\ProberControl folder, where
<AllUsersProfile> is C:\Documents and Settings\All Users on Windows XP and
C:\Program Data on Windows Vista/7/8.1/10. For details, see “Prober info.ini”.

See the following sections for how to use the prober control script.

Prober Control Script

Prober control script is sample program used for semi-automatic prober control. The
EasyEXPERT can call the script by using the Repeat Measurement Setup window.

* See “Repeat Measurements™ to call the script and perform repeat measurement.
e See “Prober_info.ini” for the prober information file.

The prober control script can be used for Start Procedure, After Measurement
Procedure, and Final Procedure on the Repeat Measurement Setup dialog box. And
use the Subsite move test setup in your quick test to control sub die move. The
Subsite move setup uses the subsite procedure for moving wafer chuck to the next
subsite. See “Subsite xxxx.exe”, “Subsite move Test Setup”, and “To Use Subsite
move”.
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Repeat Measurements

Flow of Repeat Measurement Setup

| | Start Procedure I I
Count=0

Before Measurement

Procedure

*

If Abort is clicked |@ Measurement

| Count= Count+1 |

After Measurement
Procedure
| | Abort Procedure | |
YE‘S 4—

Final Procedure

The repeat measurement is performed as shown in this flowchart. The status is a
response returned by each procedure. The Count is the accumulated number of test
executions. They are the stop condition of the repeat measurement.

The repeat measurement stop function is enabled by the following check boxes.

e Counter reaching to
¢ Procedure return condition

If the first box is checked and the limit value is specified, the repeat measurement
will be stopped if Count >= limit. To perform the repeat measurement, set the limit
value more than the number of devices under test or remove check from this box.

If the second box is checked, the repeat measurement will be stopped if status =
True.
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When the second box is checked, the device ID automatic setup function is available
and is enabled/disabled by using the following check box. The function enters the
device_id value to the Device ID of the test result record. The device idis a
response returned by each procedure.

*  Automatically fill in Device ID

The Repeat Measurement Setup dialog box provides the following action buttons.

Run: Starts repeat measurement.
Abort: Stops repeat measurement immediately.
Cancel: Closes the Repeat Measurement Setup dialog box.

Start/Before Measurement/A fter Measurement/Abort/Final Procedure:
Enter the full path name of the procedure. For example, enter as follows.

C:\Program Files\Agilent\B1500\EasyEXPERT\Utilities\ProberControl\
suss\Start_suss.exe

Arguments:

Enter the options of the procedure. See the following sections for the options. For
example, enter as follows.

—a GPIBO::5::INSTR -1 C:\temp\prb.log
If you use the subsite procedure, the flowchart must be changed below.

Replace the box A shown in Figure 8-1 with the block A shown as follows.

[ Measurement |

[ subsite Plrocedure| |
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Prober_info.ini

The prober information file is necessary to execute the prober control script. Before
starting tests, open this file, edit it as you want, and overwrite it. The name must be
prober info.ini.

Prober_info.ini

[Prober]
Address=GPIB::5:INSTR — GPIB address of prober
LogMode =True

LogName =C: ¥temp ¥prb.log | — Fyll path name of log file

[Target]
UselD=True — device_id = prefix:coordinate
Subsitelnfo =False |

Waferinfo =False <Response> JB
<Break>False</Break>

<Targearget>

</Response>

The prober_info.ini file stores the information shown below.

Address: GPIB address of prober

LogMode: Log file creation mode; True or False
LogName: Log file name (full path)

UselD: Device ID creation mode; True or False
Subsitelnfo: Set always False. This is just a place holder.
WaferInfo: Set always False. This is just a place holder.

If the procedures specify the —a option, the Address value is not used.
If the procedures specify the —1 option, the LogName value is not used.
To create a log file, set LogMode=True.

To use the prefix:coordinate format for the device id value, set UseID=True. If
UselD=False, the device id value will be coordinate, not prefix:coordinate. The
prefix will be the value entered in the Device ID Entry dialog box that is opened by
Start xxxx.exe. This function is available when the Automatically fill in Device ID
check box is checked.
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Start xxxx.exe

This script can be used for Start Procedure. It must be specified by the full path
name.

Start_xxxx.exe

« Arguments: -a GPIB_address

-l log_file_name [ Displays Device ID Entry dialog box |
Example: L
Updat ber_info.ini fil
~a GPIBO::5:INSTR -L C: ¥temp ¥prb.log ___Updates prober_info.ni e |
Displays Start Confirmation dialog b
= Response: XML format data [ Displays Start Con |rma fon dialog box_ |
<Response> [ Moves to theﬁrst position
<Break>status</Break> Prober
<Target>device_id</Target> error’7
</Response>
Gets X Ycoordmate
status: True (error) or False
device_id: prefix:coordinate
Example:
<Response> I Ch”clk up |
<Break>False</Break>
<Target>wafla:3 1</Target> | Returns response

/Response>

After the repeat measurement is started, this procedure displays the Device ID Entry
dialog box and waits for your input. On the dialog box, enter a string used for the
prefix of device id. After that, you will see the Start Confirmation dialog box that is
used to confirm your wafer setup status. Load wafer and perform wafer alignment,
then click OK on the dialog box. The procedure moves wafer chuck to the first
probing position, checks the prober status, gets the X-Y coordinate of the probing
position, and sets the wafer chuck to the UP position. At last, the procedure returns
the response.

The status is True or False. It is used for the EasyEXPERT repeat measurement stop
function. When the Procedure return condition box is checked in the Repeat
Measurement Setup dialog box, the repeat measurement will be stopped if status =
True.

The device id is a string for the Device ID of the test result record. When the
Automatically fill in Device ID box is checked in the Repeat Measurement Setup
dialog box, the device id will be entered to the Device ID of the test result record.

If you use the subsite procedure, the flowchart must be changed below.
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Insert the box B shown as follows to the position B shown in Figure 8-3.

|
[ [ Move to the 15t subsite |
I

To ignore the Arguments, set the GPIB address and log file name in the
prober info.ini.

Iterator xxxx.exe

This script can be used for After Measurement Procedure. It must be specified by
the full path name.

Iterator_xxxx.exe

+ Arguments: -a GPIB_address

-l log_file_name [ Chuck down
Example:
-a GPIBO::5:INSTR - C: ¥temp ¥prb.log
+ Response: XML format data

(Response> | Moves to the next position |
<Break>status</Break> Prober Yes
<Target>device_id</Target> error?

</Response> No

ot True (error) or Fal | GetsX -Ycoordinate |

status: rue (error) or False . >

device_id: prefix:coordinate @

Example:

<Response> I Ch“CIk up |
<Break>False</Break> I
<Target>wafla:4 1</Target> | Returns response

</Response>

The procedure is called after the measurement is completed for a die. This procedure
sets wafer chuck to the DOWN position, moves it to the next probing position,
checks the prober status, gets the X-Y coordinate of the probing position, and sets
the wafer chuck to the UP position. At last, the procedure returns the response.

The status is True or False. It is used for the EasyEXPERT repeat measurement stop
function. When the Procedure return condition box is checked in the Repeat
Measurement Setup dialog box, the repeat measurement will be stopped if status =
True.

8-18 Keysight EasyEXPERT User’s Guide Vol. 2, Edition 5



NOTE

Figure 8-5

Utilities
Utility Programs

The device id is a string for the Device ID of the test result record. When the
Automatically fill in Device ID box is checked in the Repeat Measurement Setup
dialog box, the device id will be entered to the Device ID of the test result record.

If you use the subsite procedure, the flowchart must be changed below.

Insert the box B shown as follows to the position B shown in Figure 8-3.

l
[ [ Move to the 15t subsite |
I

To ignore the Arguments, set the GPIB address and log file name in the
prober info.ini.

Final xxxx.exe

This script can be used for Final Procedure. It must be specified by the full path
name.

Final_xxxx.exe

+ Arguments: -a GPIB_address
-l log_file_name
Example:
-a GPIBO::5:INSTR - C: ¥temp ¥prb.log
- Response. none Repeat Measurement Setup
Fun Control | Procedures (1) | Procsdures (2)| Options |
'Rep&at Stop Condition
( Start ) /Stop Repeating by :
¥ Counter reachingto: |5 2]
v Reset counter before repeating
¥ Procedure return condition
[ Chuck down [ ;‘
/
End
Stop condition

Run | Cancel ‘

The procedure is called after one of the stop condition is detected. This procedure
sets wafer chuck to the DOWN position.
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To ignore the Arguments, set the GPIB address and log file name in the
prober_info.ini.

Subsite xxxx.exe

To realize sub die move operation, you need to define Subsite xxxx.exe in your test
definition and create your application test setup. However, you do not need to take
care of this procedure by using the Subsite move test setup included in the
application library. The Subsite move setup moves wafer chuck to the next subsite,
reads device ID from the prober, and sets it to the Device ID of the test result record.

Subsite_xxxx.exe

« Arguments: -a GPIB_address

-l log_file_name I Chuck down
Example:
-a GPIBO::5:INSTR -1 C: ¥temp ¥prb.log
» Response: XML format data
(Response> [ Moves to the next subsite |
<Break>status</Break> Prober Yes
<Target>device_id</Target> error?
</Response> No
[ GetsX -Ycoordinate |
status: True (error) or False
device_id: prefix:coordinate
Example:
<Response> I Chuclk up |
<Break>False</Break>
<Target>wafla:3 1</Target> | Returns feSpOﬂSE

</Response>

Open the Subsite move test setup and save it as a setup in your preset group (My
Favorite Setup). Then you can use the setup for your quick test.

To use the Subsite move setup, set the GPIB address and log file name in the
prober_info.ini. And ignore the Arguments for Subsite xxxx.exe.

If you use a Suss prober, the number of Subsite move setups used in your quick test
(die test) is important. It must be N-1; N is the number of subsites defined in the
prober.
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The status is True or False. It is used for the EasyEXPERT repeat measurement stop
function. When the Procedure return condition box is checked in the Repeat
Measurement Setup dialog box, the repeat measurement will be stopped if status =
True.

The device id is a string for the Device ID of the test result record.

Subsite move Test Setup

Click Application Test tab and open the Subsite move test setup in the Utility
category. On the Subsite move setup screen, specify ProberType (Cascade, Suss, or
Vector) or driver for your prober in CustomerProber, and save it as a setup in your
preset group (My Favorite Setup). Then you can use the setup for your quick test.
See “To Use Subsite move”.

Subsite move Test Setup
File DataDisplay Help

Category  ~ | QI}Suhsite move | Setup Name: |Substte move
] Memary '~ |Device Parameters
7 mixedsignal

2
5
=§ || NanaTech
2 | Reliability
T |00 structure E
& |0 TFT |
@ |l utility [
S| Library - | [Test Parameters
4 TRNG |
5 . " &) cascade
g ProberType: |Cascade Microtech - » %ﬁ Micratee
| o Cascade Wicrotech ] = h
Suss Microtec idvgvd
n CiebraPiabae \Vector Semicon
i @ Suss
Trng gm r > Microtec
Subsite
- 1 Vec
regne | SPECify ProberType. -
Or specify driver for your prober in o ™
22} CustomProber. S
Trng gm 3 "
classic auto g -
@ |
Subsite
move [v _ | m-out-1-7 vl
]
~ | Flag | Setup Name | Date | Count | Device ID | Remarks |L
» IN-OUT-1-7 3/7/2006 6:43:40 PM il =
| idvgvd 3/7/2006 4:49:37 PM 2 &
= SWM-open 3/7/2006 4:45:49PM 1
i 1d-vd 3/7/2006 4:45:45PM 1
idvavd 3/7/2006 4:45:33PM 1
SWM-1to7 3/7/2006 4:45:26 PM 1 ]

[ [ SMU Ze OFF |55} Auto Export ON ] Auto Record ON

The Subsite move setup moves wafer chuck to the next subsite, reads device ID
from the prober, and sets it to the Device ID of the test result record.

For more details of the test setup, open the Test Definition window.
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In the Subsite move test definition, an execution file callProbeDvr.exe is used. This
file is used to send Subsite xxxx.exe to the prober specified by the prober_info.ini
file and receive the response; status and device id. The callProberDvr.exe has the

following input/output parameters.

Input: Full path of Subsite xxxx.exe
Output: status; True (error) or False (no error)
Output: device id

The callProberDvr.exe refers to the prober_info.ini file for the GPIB address and log
file name. Do not set the Arguments of Subsite xxxx.exe.

To Use Subsite move

To Use Subsite move

File Data Display Help
g [My Favorite Setup ~ |
2

5 l Preset Group: [TRNG =l I«
% ame | |
= [ swM-1to7 <
E g v ¥y ~Quick Test List —
3 bl h 7 Select All

SWM-open Repeat Measurement Setup

% IN-OUT-1-7
Run Caritrol | Procedures (1) I Procedures (2) | Optians I

i Quick Test

Repeat Stop Condition

Stop Repeating by :

¥ Counter reachingto: |5 EI e

¥ Reset counter before repeating

Subsite
¥ Procedure return condition mave

Id-vd

SWM-
open

| Flag | Setup Name

IN-OUT-1-7
idvgvd
SWM-open
Id-vd

idvgvd | et
SWM-1ta7 Run Abort Cancel | =l

U] SMU ZSrG UFF = Ao EXpOTUN— =] Ao Record ON

IN-OUT-
17

(s

Results  + [3]

8-22 Keysight EasyEXPERT User’s Guide Vol. 2, Edition 5



Utilities
Utility Programs

To perform the test with the sub die move operation, do as follows.

1. Add the Subsite move test setup to your preset group (My Favorite setup).
2. Set your preset group and test setups in the Quick Test tab screen.
3. Open the Repeat Measurement Setup dialog box.
4. Specify the procedures and the repeat measurement condition.
Start repeat measurement.

The Subsite move setup must be entered after measurements for a sub die.
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SetupFileConverter.exe

This program is the script version of the setup file converter. This program converts
the 4155A/4156A/4155B/4156B/4155C/4156C setup file (DAT or .MES) and
creates the EasyEXPERT setup file (.XTS). This program can convert the setup
information but cannot convert the test result data.

EasyEXPERT execution environment

SetupFileConverter.exe [option] [file]

option : Execution options. See Table 8-2. Multiple options can be set. Both
/4155 and /4156 cannot be set for one execution.

file : 4155/4156 setup file name

You can specify multiple files by using a space as the separator. Also
wildcard can be used.

If no parameter is specified, the Usage message is displayed.

C:\415xConvert>SetupFileConverter.exe MOS1.MES
C:\415xConvert>SetupFileConverter.exe MOS*.DAT MOS*.MES
C:\415xConvert>SetupFileConverter.exe /4156 /HP *.MES

Option Parameter

Option Description

(no option) | Performs normal operation.

/4155 Creates the XTS file for the 4155, not for the B1500.
/4156 Creates the XTS file for the 4156, not for the B1500.
/HP Converts HPSMU in the MES/DAT file to SMUS5: HP. For creating

the XTS file for the 4155/4156.

/S Leaves Command Prompt open after execution.
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To read XTS file
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The .XTS file can be created by using Command Prompt as shown below.

1. Create your working folder (for example, C:\415xConvert\).

2. Copy the 4155/4156 setup files to convert and the SetupFileConverter.exe file,
and paste them to the working folder.

3. Open Command Prompt.

4. On Command Prompt, execute SetupFileConverter.exe as shown below. This
creates the .XTS file in the working folder and displays the message as follows.

C:\415xConvert>SetupFileConverter.exe IDVG.MES

SetupFileConverter.exe : Version A.02.10
Start Conversion : IDVG.MES
ExportFile . IDVG.xts
SetupVersion : HP4155 C03.06

Conversion successfully completed.

The .XTS file can be created by using a shortcut on the Desktop. The shortcut
should be created by the following conditions.

* Name: SetupFileConverter

o Target file:
"<program folder>\Agilent\B1500\EasyEXPERT\415xC\Conversi
on\SetupFileConverter.exe" /S

If you want to make the .XTS file for the 4155/4156, insert /4155 or /4156 before /S.
If you want to add /HP option, insert /HP before /S.

1. Create your working folder (for example, C:\415xConvert\).

2. Copy the 4155/4156 setup files to convert, and paste them to the working folder.

3. Drag the files and drop them on the SetupFileConverter icon. This creates the
XTS files in the working folder.

Use the import function to read the created .XTS file on the EasyEXPERT.

Open the Import Test Setup window by clicking File > Import Test Setup... on the
Classic Test screen. Specify the .XTS file to be imported, and click Open.
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The setup file conversion is not complete. The following are the expected
differences. When you use the .XTS file, you will see differences in the operation,
performance, measurement result data, and so on.

Channel number may be changed. For example, the HPSMU channel number is
5 for the 4155/4156 but 1 for the B1500.

Setup value is changed to the value available for the B1500 and EasyEXPERT.

Voltage Source and Monitor Unit (two channels of VSU and two channels of
VMU) is converted to four channels of MPSMU.

Pulse Generator Unit (PGU) setup is deleted.
Unused module information is deleted.
Functions only for the 4155/4156 are deleted.

For converting the setup data which satisfies the following two conditions,
SMUS is converted to HPSMU. Else, SMUS5 is converted to MPSMU.

1. SMUG6 information is not included in the setup data.

2. SMUS5 information contains the value available only for the HPSMU.

If an inconvertible setup parameter is found during the setup file conversion, a
message will be displayed. If an inconvertible setup file is specified, the file
conversion is not performed for the file and a message will be displayed.

Ifthe /4155 or /4156 option is specified, there are the following differences between
results with option the conversion results.

Channel number is not changed.

Setup value will be changed to the value available for the 4155/4156 and
EasyEXPERT.

VSU/VMU is converted to VSU/VMU respectively.
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MdmPFileConverter.exe

This program is the script version of the MDM file converter. This program converts
the EasyEXPERT test result data file (extension: xtr or ztr) and creates the Keysight
IC-CAP model data manager file (extension: mdm).

EasyEXPERT execution environment

MdmFileConverter.exe [option] [file]

option : Execution options. See Table 8-3. Multiple options can be set.
file : xtr/ztr file name

You can specify multiple files by using a space as the separator. Also
wildcard can be used.

If no parameter is specified, the MDM file converter is launched.

C:\MdmFileConvert>MdmFileConverter.exe MOS.xtr
C:\MdmFileConvert>MdmFileConverter.exe *.xtr *.ztr
C:\MdmFileConvert>MdmFileConverter.exe /o MOS1 MOS.xtr

C:\MdmFileConvert>MdmFileConverter.exe /d folderl *.xtr *.ztr

Option Parameter

Option Description

(no option) | Performs normal operation.

/o outfile Specifies the mdm file name. Only one xtr/ztr file can be specified.

/d outfold | Specifies the folder used for storing the mdm files.

N'log Specifies the file for recording the conversion log.
/s Does not record the conversion log.
/t Appends the test setup title to the mdm file name. If the xtr/ztr file

name is “abc” and the test setup title is “title”, the mdm file name
will be “abc-title”.
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The mdm file can be created by using Command Prompt as shown below.

1.
2.

Create your working folder (for example, C:\MdmConversion\).

Copy the xtr/ztr files to convert and the MdmFileConverter.exe file, and paste
them to the working folder.

Open Command Prompt.

On Command Prompt, execute MdmFileConverter.exe as shown below. This
creates the mdm file in the working folder and displays the message as follows.

C:\MdmConversion>MdmFileConverter.exe Idvd.xtr

Starting at 2013/03/27 18:11:15
Reading 'Idvd.xtr'

Converting 'Idvd'

Writing 'Idvd.mdm' .
Completed successfully.

The mdm file can be created by using a shortcut on the Desktop. The shortcut
should be created by the following conditions.

Name: MdmFileConverter

Target file:
"<program folder>\Agilent\B1500\EasyEXPERT\IC-CAP Support
\MDM\MdmFileConverter.exe" /t

Add or delete the option as you want. See Table 8-3 for the available options.

Create your working folder (for example, C:\MdmConversion\).
Copy the xtr/ztr files to convert, and paste them to the working folder.

Drag the files and drop them on the MdmFileConverter icon. This creates the
mdm files in the working folder.
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Without the /d option, the mdm file is created in the folder which the xtr/ztr file
has been stored.

With the /d option, the mdm file is created in the specified folder.

Without the /o option, the mdm file name is same as the xtr/ztr file name.
Example: MdmFileConverter.exe abc.xtr creates the abc.mdm file.

With the /o option, the mdm file is created with the specified name.
Example: MdmFileConverter.exe /o xyz abc.xtr creates the xyz.mdm file.
If the xtr/ztr file includes multiple test data, “(N)” is added to the file name.

Example: If the xtr/ztr file includes three test data, MdmFileConverter.exe
abc.xtr creates the abc.mdm, abc(1).mdm, and abc(2).mdm files.

With the /t option, the title of the test setup is added to the file name.

Example: If the title is “title”, MdmFileConverter.exe /t abc.xtr creates the
abc-title.mdm file.

If a mdm file of the same name already exists, “()” is added to the file name.

Example: If the abc.mdm file already exists, MdmFileConverter.exe abc.xtr
creates the abc(1).mdm file.
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sleep.exe
This execution file is used to put a wait time in the test execution flow of an

application test.

EasyEXPERT application test execution environment

<program folder>\Agilent\B1500\EasyEXPERT\Utilities\sleep.exe

The following parameters are available for this file. To use sleep.exe, the parameters
must be defined in the Local Variables Definition statement of the Test Contents tab
in the Test Definition window.

WAIT : List input parameter. Vector variable (1 x 1) to store the data passed
to sleep.exe. Enter a wait time in ms.

PassFail : Value output parameter. Numeric variable to store the execution
result. 0 is always returned.

ReturnValue : Value output parameter. Numeric variable to store the data returned
by executing sleep.exe. 1 is returned after execution.

To execute sleep.exe, the following setup should be done in the Command
Execution element, Miscellaneous component, Test Contents tab in the Test
Definition window.

Windows Command Execution

Command Filename:| C:\Program Files\Agilent\B1500\EasyEXPERT\Utilities\sleep.exe

Argument:

Write Type: String x | List

Read Type: String x | Value List None

Write List

Values: WAIT

Format:

Read Value

Result: PassFail Value: ReturnValue
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XSLT

The XSLT (XSL-Transformation, eXtensible Stylesheet Language Transformation)
filter files are used to export test records. The fifteen filter files listed below are
stored in the <program folder>\Agilent\B1500\EasyEXPERT\Utilities\XSLT folder.
See Table 8-4.

Filter files that contain csv in the file name export test record in the format that uses
a comma (,) as data separator.

Filter files that contain fab-sv in the file name export test record in the format that
uses a tab as data separator.

Filter files that contain xmlss in the file name export test record in the XML Spread

Sheet format.

Test record can be exported by the following procedure.

1. Open the Export in My Format dialog box by clicking Results > Transport Data
> Export in My Format....

2. Enter the XSLT filter file name, and click the Export As... button.
3. On the Export As dialog box, specify the file name and file type for the export

data, and click Save.

The exported data file can be opened and read with a spreadsheet software. The
procedure for opening the export data with a spreadsheet software is as follows.

* For data separated by a comma

Specify the data separated by a comma for the original data format.
* For data separated by a tab

Specify the data separated by a tab for the original data format.
* For data in the XML Spread Sheet format

Specify the XML file for the file type.

After reading the file, all data in the file will be entered into independent cells on the
spreadsheet software.
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Table 8-4 XSLT Filter Files
Group File name Description
1 meas-csv.xsl Filter files for exporting the measurement data only

meas-tab-sv.xsl

meas-xmlss.xsl

Classic test record export example is shown in Table 8-5.

2 meas-index-csv.xsl Filter files for exporting the measurement data with the index
meas-index-tab-sv.xsl Classic test record export example is shown in Table 8-6.
meas-index-xmlss.xsl

3 meas-meta-csv.xsl Filter Files for exporting the measurement data with the meta

t
meas-meta-tab-sv.xsl data
meas-meta-xmlss.xsl The meta data contains the test name, the setup name, the
’ record time of the test results, the device ID, the counter
number, the flag of the test results, and the remarks on the test
results.
Classic test record export example is shown in Table 8-7.
4 meas-index-meta-csv.xsl | Filter files for exporting the measurement data with the index
. and the meta data
meas-index-meta-tab-sv.xsl
meas-index-meta-xmlss xs| The meta data contains the test name, the setup name, the
) record time of the test results, the device ID, the counter
number, the flag of the test results, and the remarks on the test
results.
Classic test record export example is shown in Table 8-8.

5 csv.xsl Filter files for exporting all data including the test setup

(used by the Export As

CSV... function)

Application test record export example is shown in Table 8-9.
Data in the first cell is the label for the data components in that

tab-sv.xsl row. The following cells are the data corresponding to the
label. Table 8-12 and Table 8-13 list the components available
xmlss.xsl for the exported data file
(used by the Export As '
XML Spread Sheet...
function)
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Table 8-5 Example of the data exported by using the XSLT Filter File Group 1
vd Vg Index Time Id ABS ID Slope
0 1 1 0.00264 -0.00012 0.00012 0.004346
0.06 1 2 0.01265 0.000398 0.000398 0.004346
0.12 1 3 0.02265 0.000902 0.000902 0.004346
Table 8-6 Example of the data exported by using the XSLT Filter File Group 2
No. vd Vg Index Time Id ABS 1D Slope
1 0 1 1 0.00264 | -0.00012 0.00012 | 0.004346
2 0.06 1 2 0.01265 | 0.000398 | 0.000398 | 0.004346
3 0.12 1 3 0.02265 | 0.000902 | 0.000902 | 0.004346
Table 8-7 Example of the data exported by using the XSLT Filter File Group 3
I/V Sweep Trng 1d-Vd
Record Time | 04/04/2007
08:36:42
Device ID
Count 2
Flag
Remarks
vd Vg Index Time Id ABS ID Slope
0 1 1 0.00264 -0.00012 0.00012 0.004346
0.06 1 2 0.01265 0.000398 0.000398 0.004346
0.12 1 3 0.02265 0.000902 0.000902 0.004346
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Table 8-8 Example of the data exported by using the XSLT Filter File Group 4

I/V Sweep Trng 1d-Vd

Record 04/04/2007

Time 08:36:42

Device ID

Count 2

Flag

Remarks

No. vd Vg Index Time Id ABS ID | Slope

0 0.00264 | -0.00012 0.00012 | 0.004346
0.06 0.01265 | 0.000398 | 0.000398 | 0.004346
0.12 0.02265 | 0.000902 | 0.000902 | 0.004346
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Filter File Modification Example

This section explains the modification example of a filter file. In this example, a
filter file of group 5 is used.

The group 5 filter files will export the data that contains the test setup information.
To obtain the data without the setup information, modify the filter file as shown
below, also see Figure 8-9, and export data by using the filter file after modification.

The data will not contain the TestParameter, DutParameter, MetaData, and
AnalysisSetup of the Application test result record, and the TestParameter,
MetaData, and AnalysisSetup of the Classic test result record.

1. Modify the following femplate elements for sta:TestParameterList to
sta:TerminalList as shown below.

<xsl:template match="sta:TestParameterList">
</xsl:template>

<xsl:template match="sta:DutParameterList">
</xsl:template>

<xsl:template match="sta:AnalysisParameterList">
</xsl:template>

<xsl:template match="sta:MetaData/sta:ParameterList">
</xsl:template>

<xsl:template match="sta:TerminalList">
<xsl:apply-templates />
</xsl:template>

2. Comment out the whole of the following femplate element.

<l--

<xsl:template match="sta:Parameter">

</xsl:template>

-—>
Exported data examples of Classic test result record are shown in Table 8-9 and
Table 8-10.

Table 8-11 explains the reference name used in the filter file and shows the relation
to the parameter name used in the data file exported by using the filter file.
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Modification Example

Figure 8-9

Before modification

After modification

<xsl:template match="sta:TestParameterList">
<xsl:apply-templates select="sta:Parameter">
<xsl:with-param name="parmtag">TestParameter</xsl
</xsl:apply-templates>
</xsl:template>

ith-param>

<xsl:template match="sta:TestParameterList">
</xsl:template>

<xsl:template match="sta:DutParameterList">
<xsl:apply-templates select="sta:Parameter">
<xsl:with-param name="parmtag">DutParameter</xsl:with-param>
</xsl:apply-templates>
</xsl:template>

<xsl:template match="sta:DutParameterList">
</xsl:template>

<xsl:template match="sta:AnalysisParameterList">
<xsl:apply-templates select="sta:Parameter">
<xsl:with-param name="parmtag">AnalysisSetup</xsl:with-param>
</xsl:apply-templates>
</xsl:template>

<xsl:template match="sta:AnalysisParameterList">
</xsl:template>

<xsl:template match="sta:MetaData/sta:ParameterList">
<xsl:apply-templates select="sta:Parameter">
<xsl:with-param name="parmtag">MetaData</xsl:with-param>
</xsl:apply-templates>
</xsl:template>

<xsl:template match="sta:TerminalList">

<xsl:template match="sta:MetaData/sta:ParameterList">
</xsl:template>

<xsl:template match="sta:TerminalList">

<xsl:apply-templates select="sta:Terminal"™ />
</xsl:template>

<xsl:template match="sta:Parameter">
<xsl:param name="parmtag">UnknownParameter</xsl:param>
<xsl:if test="@Index='0"'">
<xsl:variable name="parmname" select="@Name" />
<xsl:text xml:space="preserve">
</xsl:text>
<xsl:value-of select="$parmtag" />
<xsl:text>, </xsl:text>
<xsl:value-of select="$parmname" disable-output-escaping="yes" />
<xsl:apply-templates />
<xsl:for-each select="../sta:Parameter[@Name=$parmname and @Index>'0']">
<xsl:sort select="@Index" data-type="number" />
<xsl:apply-templates />
</xsl:for-each>
</xsl:if>
</xsl:template>

- <xsl:apply-templates />
</xsl:template>

<xsl:template match="sta:Parameter">
<xsl:param name="parmtag">UnknownParameter</xsl:param>
<xsl:if test="@Index='0'">
<xsl:variable name="parmname" select="@Name" />
<xsl:text xml:space="preserve">
</xsl:text>
<xsl:value-of select="S$parmtag" />
<xsl:text>, </xsl:text>
<xsl:value-of select="$parmname" disable-output-escaping="yes" />
<xsl:apply-templates />
<xsl:for-each select="../sta:Parameter[@Name=$parmname and @Index>'0']">
<xsl:sort select="@Index" data-type="number" />
<xsl:apply-templates />
</xsl:for-each>
</xsl:if>
</xsl:template>

>
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Table 8-9 Example of the data exported by using the filter file before modification
SetupTitle Trng Id-Vd

PrimitiveTest |I/V Sweep

TestParameter | Channel.Unit SMU1:HP SMU2:HP SMU3:HR SMU4:HR
TestParameter | Channel.IName |Id Ig Is Isub
TestParameter | Channel.VName|Vd Vg Vs Vsub
MetaData TestRecord.Entr | true

AnalysisSetup | Analysis.Setup. |true

Dimensionl 51 51 51 51 51
Dimension2 3 3 3 3 3
DataName vd Vg Index Time Id
DataValue 0 1 1 0.00251 0
DataValue 0.06 1 2 0.01251 3.35E-05
Table 8-10 Example of the data exported by using the filter file after modification
SetupTitle Trng 1d-Vd

PrimitiveTest |I/V Sweep

Dimensionl 51 51 51 51 51
Dimension2 3 3 3 3 3
DataName vd Vg Index Time Id
DataValue 0 1 1 0.00251 0
DataValue 0.06 1 2 0.01251 3.35E-05
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Table 8-11

Filter File Reference Name

Reference name

Description

sta:TestData

Indicates a test result data saved in an EasyEXPERT test result record

sta:MeasurementData

Indicates a measurement result data saved in a test result data

sta:DataVectorSet

Indicates a set of vector data saved in a measurement result data

sta:TestSetup

Indicates a test setup data saved in a test result data

sta:Title

Indicates test setup name, SetupTitle in export data

sta:PrimitiveTest

Indicates a classic test data set, PrimitiveTest in export data

sta:ApplicationTest

Indicates an application test data set, ApplicationTest in export data

sta:TestParameterList

Indicates a set of Test Parameters definitions, TestParameter in export
data

sta:DutParameterList

Indicates a set of Device Parameters definitions, DutParameter in
export data

sta:AnalysisParameterList

Indicates a set of display and analysis data, AnalysisSetup in export
data

sta:MetaData/sta:ParameterList

Indicates a set of system data, MetaData in export data

sta:TerminalList

Indicates a set of terminal information

sta:Parameter

Indicates a parameter

sta:Number Indicates an integer data
sta:Double Indicates a real data
sta:String Indicates a string data

sta:Boolean

Indicates a boolean data

sta:DateTime

Indicates a date time data

sta:Binary

Indicates a binary data

sta:Channel

Indicates a channel information

sta:Terminal

Indicates a terminal information

sta:Port

Indicates a port information
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Table 8-12 Export Data Components for Classic Test Result
Label Description Example (csv output)

SetupTitle Title of this test setup Trng 1d Vd

PrimitiveTest Setup name of this classic test I/V Sweep

TestParameter Parameter name and setup value of Channel Channel.Unit, SMU1:HP,
Setup, Measurement Setup, Function Setup, Auto | SMU2:HP, SMU3:HR,
Analysis Setup, and Display Setup. SMU4:HR
Data file contains a lot of rows for TestParameter.
One setup item per row.

MetaData Data for system use. Test record entry point, TestRecord.EntryPoint, true
record time, test target, iteration index,
preservation, flag, remarks, and link key.

AnalysisSetup Parameter name and setup value of the data Analysis.Setup. Vector.Graph.E
display and analysis setup. nabled, true
Data file contains a lot of rows for
AnalysisParameter. One setup item per row.

Dimension1 Size of data variable. For dimension 1. Order 51,51, 51,51, 51
sensitive. 51 for all data variables in Example.

Dimension2 Size of data variable. For dimension 2. Order 3,3,3,3,3
sensitive. 1 for all data variables in Example.

DataName Measurement parameter names or data variable Vd, Vg, Index, Time, Id
names. Order sensitive. For example, Vgate=-0.5
in Example.

DataValue Measurement result data. Order sensitive. For 0,1,1,0.00251,0

example, Vgate=-0.5 in Example.

Data file contains a lot of rows for DataValue.
One data set per row.
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Table 8-13 Export Data Components for Application Test Result
Label Description Example (csv output)
SetupTitle Title of this test setup Trng 1d Vd
ApplicationTest | Setup name of this application test Trng 1d_Vd, Public
TestParameter Two rows. The upside is for the test parameter Name, VdStart, VdStop,
names. The downside is for the test parameter VdStep, VgStart, VgStop,
values. Order sensitive. For example, Vd=0.1 in VgStep, Vs
Example.
Value, 0, 3, 0.06, 1,2,0.5,0
DutParameter Two rows. The upside is for the device parameter | Name, Polarity, Lg, Wg, Temp,
names. The downside is for the device parameter | IdMax
values. Order sensitive. For example, Temp=25 in
Example. Value, 1, 1.00E-07, 1.00E-05,
25, 0.005
MetaData Data for system use. Test record entry point, TestRecord.EntryPoint, true
record time, test target, iteration index,
preservation, flag, remarks, and link key.
AnalysisSetup Parameter name and setup value of the data Analysis.Setup.Vector.Graph.E
display and analysis setup. nabled, true
Data file contains a lot of rows for
AnalysisParameter. One setup item per row.
Dimensionl Size of data variable. For dimension 1. Order 51,51, 51,51, 51
sensitive. 51 for all data variables in Example.
Dimension2 Size of data variable. For dimension 2. Order 3,3,3,3,3
sensitive. 1 for all data variables in Example.
DataName Measurement parameter names or data variable Vd, Vg, Index, Time, Id
names. Order sensitive. For example, Vgate=-0.5
in Example.
DataValue Measurement result data. Order sensitive. For 0,1,1,0.00251,0

example, Vgate=-0.5 in Example.

Data file contains a lot of rows for DataValue.
One data set per row.
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Application Library

This chapter lists the application tests provided by EasyEXPERT. This chapter also
describes the maximum measurement value and accuracy for the result data
measured by using the QSCV[2] application test.

*  “Application Test Definitions”

*  “QSCV Maximum Measurement Value and Accuracy”
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Application Test Definitions

Keysight EasyEXPERT software contains the application library which supports the
several characteristic measurements listed in Table 9-1. They are classified into the
following categories.

« BIT
¢ CMOS
¢ Discrete

¢ GenericTest

« MCSMU_IV
*  Memory

*  MixedSignal
* NanoTech

* Organic

*  PwrDevice

* Reliability

* Sample

» Solar Cell

« SPGU_PLSDIV

e Structure

« TFT

« Utility

« WGFMU

+  WGFMU Utility
« WGFMU_IV

* GaN Diode

* GaNFET

+ IGBT
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¢ Interconnection

e MISCAP
< PMIC
e  PowerBIT

*  PowerDiode

*  PowerMOSFET
« SiC

* GateCharge

* GateChargeUtilities

« NI272A
e NI274A
¢ Thermal

*  MultiHVSMU

¢ Advanced NVM
« Utility (NVM)

e Thyristor

All test definitions are just sample. If the samples damage your devices, Keysight
Technologies is NOT LIABLE for the damage.

If you delete a test definition

Application library should be recovered. Import the test definition by using the
Import Test Definition... function of the Library button. The original test definitions
are stored in the following folders.

<program folder>\Agilent\B1500\EasyEXPERT\Application Tests
<program folder>\Agilent\B1500\EasyEXPERT\Contribution\Application Tests

9-4
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Table 9-1 Application Test Definitions
Category Test definition name Supported instrument Required equipment and quantity
BJT BC Diode Fwd B1500A, ES260A, E5262A, SMU 2

E5263A, E5270B

BC Diode Fwd [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

BC diode Rev

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 2

BC diode Rev [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

BVcbo

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 2

BVcbo [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

BVcei

BVceo

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 3

SMU 2

BVceo [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUx2. See Figure 2.

BVebo

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 2

BVebo [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUx2. See Figure 2.

CS Diode Fwd B1500A, E5260A, E5262A, SMU 2
E5263A, E5270B

CS Diode Fwd [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL

CS Diode Rev B1500A, E5260A, E5262A, SMU 2

E5263A, E5270B

CS Diode Rev [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUx2. See Figure 2.

Ctc-Freq Log B1500A MFCMU 1
Ctc-Ve MFCMU 1
Cte-Ve MFCMU 1
Cts MFCMU 1
EB Diode Fwd B1500A, ES260A, E5262A, SMU 2
EB Diode Rev ES263A, E52708 SMU 2

EB Diode Fwd [2HL]

EB Diode Rev [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUx2. See Figure 2.

SMUXx2. See Figure 2.

G-Plot ConstVce Pulse

B1500A, E5260A, E5270B

SMU 4
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Category

Test definition name

Supported instrument

Required equipment and quantity

BIT

G-Plot ConstVce Pulse[3]

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 3

G-Plot ConstVce Pulse [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

G-Plot ConstVce

B1500A, E5260A, E5270B

SMU 4

G-Plot ConstVcee[3]

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 3

G-Plot ConstVce [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUx2. See Figure 2.

G-Plot Vbc=0V Pulse

B1500A, E5260A, E5270B

SMU 4

G-Plot Vbc=0V Pulse[3]

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 3

G-Plot Vbc=0V Pulse [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

G-Plot Vbe=0V

B1500A, E5260A, E5270B

SMU 4

G-Plot Vbc=0V[3]

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 3

G-Plot Vbc=0V [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

hfe-Vbe ConstVce B1500A, E5260A, E5270B SMU 4
hfe-Vbe Vbc=0V SMU 4
Ie-Ve Ib SMU 4
Ic-Ve Ib[3] B1500A, ES260A, E5262A, SMU 3

E5263A, E5270B

Ic-Ve Ib [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

Ic-Vc Pulse Ib

B1500A, E5260A, E5270B

SMU 4

Ic-Vc Pulse Ib[3]

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 3

Ic-Vc Pulse Ib [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUx2. See Figure 2.

Ic-Vc Pulse Vb

B1500A, E5260A, E5270B

SMU 4

Ic-Ve Pulse Vb[3]

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 3

Ic-Ve Pulse Vb [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

Ie-Ve Vb B1500A, E5260A, E5270B SMU 4
Ic-Ve Vb[3] B1500A, E5260A, E5262A, SMU 3
E5263A, E5270B
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Category Test definition name Supported instrument Required equipment and quantity
BIT Ie-Ve Vb [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL
Rb B1500A, E5260A, E5270B SMU 4
Rb [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL
Re+Rc B1500A, E5260A, E5270B SMU 4
Re SMU 4
Simple Gummel Plot B1500A, E5260A, E5262A, SMU 3
E5263A, E5270B
Simple Gummel Plot [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL
Vbe-Le B1500A, E5260A, E5270B SMU 4, B2200A/B2201A 1
Vbe-We SMU 4, B2200A/B2201A 1
CMOS BVdss B1500A, E5260A, E5270B SMU 4

BVdss [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

BVgso

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 3

BVgso [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

Cgb-AC Level

Cgb-Freq Log

Cgb-Vg HighVoltage

Cgb-Vg

Cgc-Freq Log

B1500A

MFCMU 1, SMU 1

MFCMU 1, SMU 1

MFCMU 1, SMU 3, SCUU 1, GSWU 1

MFCMU 1, SMU 1

MFCMU 1, SMU 1

Cge-Vg MFCMU 1, SMU 1
Cgg-Freq Linear MFCMU 1
Cgg-Freq Log MFCMU 1
Cgg-Vg 2Freq MFCMU 1
Cgg-Vg MFCMU 1
IdRdsGds B1500A, E5260A, E5270B SMU 4

1d-Vd pulse SMU 4

T1dRdsGds [2HL]

1d-Vd pulse [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUx2. See Figure 2.

SMUx2. See Figure 2.

1d-Vd pulse[3] B1500A, E5260A, E5262A, SMU 3
E5263A, E5270B
1d-Vd B1500A, E5260A, E5270B SMU 4
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Category Test definition name Supported instrument Required equipment and quantity
CMOS 1d-Vd[3] B1500A, ES260A, E5262A, SMU 3

ES5263A, E5270B

1d-Vd [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL

1d-Vg pulse B1500A, E5260A, E5270B SMU 4

1d-Vg Vpulse[3] B1500A, E5260A, E5262A, SMU 3
ES5263A, E5270B

Id-Vg B1500A, E5260A, E5270B SMU 4

1d-Vg[3] B1500A, ES260A, E5262A, SMU 3
E5263A, E5270B

TonloffSlope B1500A, E5260A, E5270B SMU 4

TonloffSlope [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL

Isub-Vg B1500A, E5260A, E5270B SMU 4

QSCV[4] B1500A, BISO5A SMU 5

Simple Cgb B1500A MFCMU 1

Simple Vth B1500A, E5260A, E5270B SMU 4

Simple Vth [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL

Vth Const Id B1500A, E5260A, E5270B SMU 4

Vth Const Id [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL

Vth gmMax B1500A, E5260A, E5270B SMU 4

Vth gmMax [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL

Vth gmMax and Id B1500A, E5260A, E5270B SMU 4

VthAndCgg-Vg ASU B1500A MFCMU 1, SMU 1, ASU+SMU 2

VthAndCgg-Vg SCUU MFCMU 1, SMU 3, SCUU 1, GSWU 1

Vth-Lg B1500A, E5260A, E5270B SMU 4, B2200A/B2201A 1

Vth-Wg SMU 4, B2200A/B2201A 1

Discrete BJT GummelPlot B1500A, E5260A, ES262A, SMU 3
BIT Ie-Ve Ib E52634, E5270B SMU 3

BIT Ic-Ve Ib [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUx2. See Figure 2.

Diode IV Fwd B1500A, E5260A, E5262A, SMU 2
E5263A, E5270B
Diode IV Fwd [1HL] B2901A/B, B2902A/B, B2901BL, | SMUxI. See Figure 1.
B2911A/B, B2912A/B, B2910BL
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Discrete Diode IV Rev B1500A, E5260A, ES262A, SMU 2
E5263A, E5270B
Diode IV Rev [1HL] B2901A/B, B2902A/B, B2901BL, | SMUx1. See Figure 1.
B2911A/B, B2912A/B, B2910BL
FET Id-Vd B1500A, E5260A, E5262A, SMU 3
E5263A, E5270B
FET Id-Vd [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL
FET Id-Vg B1500A, E5260A, E5262A, SMU 3
E5263A, E5270B
FET Id-Vg [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL
GenericTest Generic C-f B1500A, B1505A, B1506A MFCMU 1
Generic C-t MFCMU 1
Memory Flash Ccf-V B1500A MFCMU 1
Flash Cgg-Vcg MFCMU 1
Flash Cfb-V MFCMU 1

NandFlash2 Endurance 3devices

NandFlash2 Endurance

NandFlash2 IV-Erase-IV

NandFlash2 IV-Write-1V

NandFlash2
Retention(ErasedCell)

NandFlash2
Retention(WrittenCell)

NandFlash2
Vth(ErasingTimeDependence)

NandFlash2
Vth(WritingTimeDependence)

NandFlash2
WordDisturb(ErasedCell)

NandFlash2
WordDisturb(WrittenCell)

NandFlash3 Endurance

NandFlash3 IV-Erase-1V

SMU 3, B2200A/B2201A 1,
81110A (2 outputs) 1

ASU+SMU 3, 81110A (2 outputs) 1

SMU 1, ASU+SMU 2,
81110A (2 outputs) 1

SMU 2, ASU+SMU 1,
81110A (2 outputs) 1

SMU 1, ASU+SMU 2,
81110A (2 outputs) 1

SMU 2, ASU+SMU 1,
81110A (2 outputs) 1

SMU 1, ASU+SMU 2,
81110A (2 outputs) 1

SMU 2, ASU+SMU 1,
81110A (2 outputs) 1

ASU+SMU 3, 81110A (2 outputs) 1

SMU 2, ASU+SMU 1,
81110A (2 outputs) 1

SPGU 1, ASU+SMU 3] or
SPGU 1, SMU 3, 16440A/16445A 2]

SPGU 1, SMU 1, ASU+SMU 2] or

[
[
[
[SPGU 1, SMU 3, 16440A/16445A 1]
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Memory NandFlash3 IV-Write-IV B1500A [SPGU 1, SMU 2, ASU+SMU 1] or
[SPGU 1, SMU 3, 16440A/16445A 1]
NandFlash3 [SPGU 1, SMU 1, ASU+SMU 2] or
Retention(ErasedCell) [SPGU 1, SMU 3, 16440A/16445A 1]
NandFlash3 [SPGU 1, SMU 2, ASU+SMU 1] or
Retention(WrittenCell) [SPGU 1, SMU 3, 16440A/16445A 1]
NandFlash3 [SPGU 1, SMU 1, ASU+SMU 2] or
Vth(ErasingTimeDependence) [SPGU 1, SMU 3, 16440A/16445A 1]
NandFlash3 [SPGU 1, SMU 2, ASU+SMU 1] or
Vth(WritingTimeDependence) [SPGU 1, SMU 3, 16440A/16445A 1]
NandFlash3 [SPGU 1, ASU+SMU 3] or
WordDisturb(ErasedCell) [SPGU 1, SMU 3, 16440A/16445A 2]
NandFlash3 [SPGU 1, SMU 2, ASU+SMU 1] or
WordDisturb(WrittenCell) [SPGU 1, SMU 3, 16440A/16445A 1]
NorFlash Endurance [SPGU 2, SMU 1, ASU+SMU 3] or
[SPGU 2, SMU 4, 16440A/16445A 2]
NorFlash IV-Erase-1V [SPGU 1, SMU 2, ASU+SMU 2] or
[SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash IV-Write-1V [SPGU 1, SMU 2, ASU+SMU 2] or
[SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash Retention(ErasedCell) [SPGU 1, SMU 2, ASU+SMU 2] or
[SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash Retention(WrittenCell) [SPGU 1, SMU 2, ASU+SMU 2] or
[SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash [SPGU 1, SMU 2, ASU+SMU 2] or
Vth(ErasingTimeDependence) [SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash [SPGU 1, SMU 2, ASU+SMU 2] or
Vth(WritingTimeDependence) [SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash [SPGU 1, SMU 2, ASU+SMU 2] or
WordDisturb(ErasedCell) [SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash [SPGU 1, SMU 2, ASU+SMU 2] or
WordDisturb(WrittenCell) [SPGU 1, SMU 4, 16440A/16445A 1]
NorFlash [SPGU 2, SMU 1, ASU+SMU 3] or
DataDisturb(ErasedCell) [SPGU 2, SMU 4, 16440A/16445A 2]
NorFlash [SPGU 1, SMU 2, ASU+SMU 2] or
DataDisturb(WrittenCell) [SPGU 1, SMU 4, 16440A/16445A 1]
MixedSignal | BJT Varactor CV Mismatch B1500A MFCMU 1
Diff-R Mismatch B1500A, E5260A, E5270B SMU 8
Diode IV Fwd Mismatch B1500A, E5260A, E5262A, SMU 3
Diode IV Rev Mismatch E5263A, E5270B SMU 3
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MixedSignal G-Plot ConstVce Mismatch B1500A, E5260A, E5270B SMU 6
G-Plot ConstVce Mismatch[3] SMU 5
G-Plot Vbc=0V Mismatch SMU 6
G-Plot Vbec=0V Mismatch[3] B1500A, E5260A, E5270B SMU 5
Ic-Vc Ib Mismatch SMU 6
Ic-Ve Ib Mismatch[3] SMU 5
Ic-Ve Vb Mismatch SMU 6
Ic-Vc Vb Mismatch[3] SMU 5
1d-Vd Mismatch SMU 5
1d-Vd Mismatch[3] SMU 4
1d-Vg Mismatch SMU 5
1d-Vg Mismatch[3] SMU 4
MIM CV Mismatch B1500A MFCMU 1
MOS Varactor CV Mismatch MFCMU 1
Poly-R Mismatch B1500A, E5260A, E5270B SMU 7
NanoTech CNT Differential R[AC] B1500A MFCMU 1
CNT Gate Leak B1500A, E5260A, E5262A, SMU 2
ES5263A, E5270B
CNT Gate Leak [1HL] B2901A/B, B2902A/B, B2901BL, | SMUx1. See Figure 1.
B2911A/B, B2912A/B, B2910BL
CNT Id-Time B1500A, E5260A, E5270B SMU 4

CNT Id-Time [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

CNTId vd

B1500A, E5260A, E5270B

SMU 4

CNTId_Vd [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

CNTId Vg

B1500A, E5260A, E5270B

SMU 4

CNTId_Vg [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUx2. See Figure 2.

CNT Id-Vg-Time

B1500A, E5260A, E5270B

SMU 4

CNT Id-Vg-Time [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

CNT IV Sweep

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 2

CNT IV Sweep [1HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUxI1. See Figure 1.

Keysight EasyEXPERT User’s Guide Vol. 2, Edition 5



Application Library

Application Test Definitions

Category Test definition name Supported instrument Required equipment and quantity
NanoTech CNT R-I Kelvin 2SMU B1500A, ES260A, E5262A, SMU 2
CNTR-V Kelvin 2SMU ES263A, E5270B SMU 2
CNT Vth gmMax B1500A, E5260A, E5270B SMU 4
CNT Vth gmMax [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL
PwrDevice BVdss[3] PwrDevice BI1500A, E5260A, E5262A, SMU 3
BVgso[3] PwrDevice E5263A, E5270B SMU 2
1d-Vd pulse[3] PwrDevice SMU 3
1d-Vd[3] PwrDevice SMU 3
1d-Vg pulse[3] PwrDevice SMU 3
1d-Vg[3] PwrDevice SMU 3
Vth Const Id[3] PwrDevice SMU 3
Vth gmMax[3] PwrDevice SMU 3
Reliability BJT EB RevStress 3devices B1500A, ES260A, E5270B SMU 6, B2200A/B2201A 1

BJT EB RevStress 3devices[3]

SMU 5, B2200A/B2201A 1

BJT EB RevStress SMU 4
BJT EB RevStress2 SMU 4
BIT EB RevStress[3] BI500A, E5260A, ES262A, SMU 3
BJT EB RevStress2[3] E5263A, E5270B SMU 3

BTI 3devices B1500A, E5260A, E5270B SMU 5, B2200A/B2201A 1
BTI 3devices[3] SMU 5, B2200A/B2201A 1
BTI SMU 4
BTI2 SMU 4
BTI[3] B1500A, ES260A, E5262A, SMU 3
BTI2[3] ES5263A, E5270B SMU 3
Charge Pumping B1500A SMU 2, 81110A (2 outputs) 1
Charge Pumping2 SMU 2, SPGU 1
EM Istress B1500A, E5260A, E5270B SMU 4
EM Istress2 SMU 4
EM Istress[2] B1500A, ES260A, E5262A, SMU 2
EM Istress2[2] E5263A, E5270B SMU 2
EM Istress[6] B1500A, ES260A, E5270B SMU 6
EM Istress2[6] SMU 6
EM Vstress SMU 4
EM Vstress2 SMU 4
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Reliability EM Vstress[2] B1500A, ES260A, E5262A, SMU 2
EM Vstress2[2] E5263A, E5270B SMU 2
EM Vstress[6] B1500A, ES260A, E5270B SMU 6
EM Vstress2[6] SMU 6
HCI 3devices SMU 8
HCI SMU 4
HCI2 SMU 4
J-Ramp B1500A, E5260A, E5262A, SMU 2

ES5263A, E5270B

TDDB Istress 3devices B1500A, E5260A, E5270B SMU 4
TDDB Istress2 3devices SMU 4
TDDB Istress B1500A, ES260A, E5262A, SMU 2
TDDB Istress2 ES263A, E5270B SMU 2
TDDB Vstress 3devices B1500A, E5260A, E5270B SMU 4
TDDB Vstress2 3devices SMU 4
TDDB Vstress B1500A, E5260A, E5262A, SMU 2
TDDB Vstress2 E52634, ES270B SMU 2
Timing On-the-fly NBTI B1500A, E5260A, E5270B SMU 4
Timing On-the-fly NBTI -Mch B1500A SMU 4 or SMU 7
TZDB B1500A, ES260A, E5262A, SMU 2
V-Ramp E5263A, E5270B SMU 2

Structure BVgb ThinOx B1500A, E5260A, E5262A, SMU 2

E5263A, E5270B

BVgb ThinOx [IHL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUx1. See Figure 1.

BVgb B1500A, E5260A, E5262A, SMU 2
E5263A, E5270B
BVgb [1HL] B2901A/B, B2902A/B, B2901BL, | SMUx1. See Figure 1.

B2911A/B, B2912A/B, B2910BL

Cgb-Freq[2] Log

Cgb-Vg 2Freq

Cgb-Vg[2]

Cj-Freq Log

Cj-v

Diode BVAndCj-V ASU

Diode BVAndCj-V SCUU

B1500A

MFCMU 1

MFCMU 1

MFCMU 1

MFCMU 1

MFCMU 1

MFCMU 1, ASU+SMU 2

MFCMU 1, SMU 2, SCUU 1, GSWU 1
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Structure

Ig-Vg Iforce

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 2

Ig-Vg Iforce [1HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUx1. See Figure 1.

Ig-Vg Vforce

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 2

Ig-Vg Vforce [1HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUxI1. See Figure 1.

Interconnect CouplingCap B1500A MFCMU 1
Interconnect OverlapCap MFCMU 1
Junction BV B1500A, E5260A, E5262A, SMU 2

E5263A, E5270B

Junction BV [1HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUx1. See Figure 1.

Junction DcParam

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 2

Junction DcParam [1HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUxI1. See Figure 1.

Junction IV Fwd

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 2

Junction IV Fwd [1HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUxI1. See Figure 1.

Junction IV Rev

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 2

Junction IV Rev [1HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUx1. See Figure 1.

QSCVI[2] B1500A, B1505A SMU 3
QSCV C Offset Meas SMU 2
Rdiff-I kelvin B1500A, E5260A, E5270B SMU 5
Rdiff-1 B1500A, ES260A, E5262A, SMU 3

E5263A, E5270B

Rdiff-1 [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

Rdiff-V

B1500A, E5260A, E5262A,
E5263A, E5270B

SMU 3

Rdiff-V [2HL]

B2901A/B, B2902A/B, B2901BL,
B2911A/B, B2912A/B, B2910BL

SMUXx2. See Figure 2.

Rdiff-V kelvin B1500A, E5260A, ES270B SMU 5
R-I DVM B1500A, ES260A, E5262A, SMU 2, 3458A 1
E5263A, E5270B
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Structure R-I kelvin B1500A, E5260A, E5270B SMU 4
R-I kelvin [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL
R-I BI1500A, E5260A, E5262A, SMU 2
E5263A, E5270B
R-I[1HL] B2901A/B, B2902A/B, B2901BL, | SMUx1. See Figure 1.
B2911A/B, B2912A/B, B2910BL
R-VDVM BI1500A, E5260A, E5262A, SMU 2, 3458A1
E5263A, E5270B
R-V kelvin B1500A, E5260A, E5270B SMU 4
R-V kelvin [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL
R-V B1500A, E5260A, E5262A, SMU 2
E5263A, E5270B
R-V [1HL] B2901A/B, B2902A/B, B2901BL, | SMU
B2911A/B, B2912A/B, B2910BL
VanDerPauw Square B1500A, E5260A, E5270B SMU 4
VanDerPauw Square [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL
Van Der Pau NonUniform B1500A SMU 4
Utility Van Der Pau NonUniform Child
(Auxiliary)? | CalcRs
TFT TFT Id-Vd BI1500A, E5260A, E5262A, SMU 3
TFT 1d-Vg E5263A, E5270B SMU 3
Utility CV Curve Parameter Calculator

CVSweep4284_a

4284A 1 or E4980A 1

ForcePG1 81110A (2 outputs) 1
ForcePG2 81110A (2 outputs) 1
ForcePG2P 81110A (2 outputs) 1
ForcePG12 81110A (2 outputs) 1
ForcePG 81110A (2 outputs) 1
ForcePGC 81110A (2 outputs) 1
Measure Diff-V 3458A'1

QSCV C Offset Meas B1500A, B1505A SMU 2

ResetPG 81110A (2 outputs) 1

Subsite move

TSet_T2420

Wafer prober 1

Thermonics T-2420
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Power Vds-Vgs B1505A, B1506A HCSMU 1, SMU 1

MOSFET 14 Vs for Expanders NI1265A 1, MC/HCSMU 2, SMU 1
TDDB Constant V SMU 1
Ciss (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
Coss (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
Crss (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
Cgs (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
Cds (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
Cgd (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
Rg(N1272A) for PowerMOSFET MPSMU 1, HVSMU 1, MFCMU 1
Ciss-Vgs (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
IDSS (N1272A) MPSMU 1, HVSMU 1
IGSS (N1272A) MPSMU 1, HVSMU 1

MCSMU_IV | Id-Vds MCSMU B1500A [[MCSMU 1 and MP/HP/HRSMU 1]

or MCSMU 2] and [MP/HP/HRSMU 2

1d-Vgs MCSMU
or [MP/HP/HRSMU 1 and GNDU]]

1d-Vgs MCSMU 2-stage

Organic 2-terminal dual Vsweep B1500A [SMU 1 and GNDU] or SMU 2

2-terminal dual Vsweep [1HL] B2901A/B, B2902A/B, B2901BL, | SMUx1. See Figure 1.
B2911A/B, B2912A/B, B2910BL

Sample Vth gmMax and Id B1500A, B5260A, E5270B SMU 4
Vth gmMax and Id [2HL] B2901A/B, B2902A/B, B2901BL, | SMUx2. See Figure 2.
B2911A/B, B2912A/B, B2910BL
Solar Cell Solar Cell IV B1500A [SMU 1 and GNDU] or SMU 2
Solar Cell IV [1HL] B2901A/B, B2902A/B, B2901BL, | SMUxI. See Figure 1.
B2911A/B, B2912A/B, B2910BL
Solar Cell IV Fwd B1500A [SMU 1 and GNDU] or SMU 2
Solar Cell IV Fwd [1HL] B2901A/B, B2902A/B, B2901BL, | SMUx1. See Figure 1.
B2911A/B, B2912A/B, B2910BL
Solar Cell IV Rev B1500A [SMU 1 and GNDU] or SMU 2
Solar Cell IV Rev [1HL] B2901A/B, B2902A/B, B2901BL, | SMUx1. See Figure 1.

B2911A/B, B2912A/B, B2910BL
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Solar Cell Solar Cell Cp-V B1500A MFCMU 1
Solar Cell Nc-W MFCMU 1
Solar Cell Cp-Freq Log MFCMU 1
Solar Cell Nyquist Plot MFCMU 1
Solar Cell Cp-AC Level MFCMU 1
Solar Cell DLCP MFCMU 1
SPGU_ SPGU PLSDIV B1500A SPGU 1
PLSDIV- SpGU PLSDIV 1d-Vd SPGU 1
SPGU PLSDIV 1d-Vg SPGU 1
WGFMU Fast BTI(ACstress Id-Sampling) | B1500A WGFMU 1, RSU 2
dgéﬁiifftof Fast BTI(DCstress Id-Sampling) WGFMU 1, RSU 2
WGFMU Fast BTI(ACstress I1d-Vg) WGFMU 1, RSU 2
Utility) Fast BTI(DCstress Id-Vg) WGFMU 1, RSU 2
TRANSIV DC 1dvd SMU 2, WGFMU 1, RSU 2
TRANSIV DC IdVg SMU 2, WGFMU 1, RSU 2
WGFMU Pattern Editor WGFMU 1, RSU 2
WGFMU Fast BTI Id-Sampling child B1500A WGFMU 1, RSU 2
Utility* Fast BTI Id-Sampling child2 WGFMU 1, RSU 2
Fast BTI Id-Vg child WGFMU 1, RSU 2
Fast BTI Id-Vg child2 WGFMU 1, RSU 2
Fast BTI Pattern Editor Child WGFMU 1, RSU 2
DataDisplay
WGFMU_IV | WGFMU DCIV B1500A WGFMU 1, RSU 2
WGFMU PLSDIV WGFMU 1, RSU 2
WGFMU Id-Vd (DC) WGFMU 1, RSU 2
WGFMU 1d-Vg (DC) WGFMU 1, RSU 2
WGFMU Id-Vd pulse WGFMU 1, RSU 2
WGFMU Id-Vg pulse WGFMU 1, RSU 2
GaN Diode Diode Current Collapse I'V-t B1505A N1267A 1, HVSMU 1, HCSMU 1,

Sampling

Diode Current Collapse Signal
Monitor

MCSMU 1

N1267A 1, HVSMU 1, HCSMU 1,
MCSMU 1
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GaN FET FET Current Collapse I'V-t B1505A
Sampling (I Force)

FET Current Collapse I'V-t
Sampling

FET Current Collapse Signal
Monitor (I Force)

FET Current Collapse Signal
Monitor

1d-Vds Current Collapse

1d-Vds Current Collapse (Pulse)

N1267A 1, HVSMU 1, HCSMU 1,
MCSMU 2, SMU 1

N1267A 1, HVSMU 1, HCSMU 1,
MCSMU 2, SMU 1

N1267A 1, HVSMU 1, HCSMU 1,
MCSMU 2, SMU 1

N1267A 1, HVSMU 1, HCSMU 1,
MCSMU 2, SMU 1

N1267A 1, HVSMU 1, HCSMU 1,
MCSMU 2, SMU 1

N1267A 1, HVSMU 1, HCSMU 1,
MCSMU 2, SMU 1

IGBT Cce B1505A, BIS06A

Cgc

Cge

Cge-Vge
Ic(off)-Vee
Ic-Vee

Ic-Vge
Vce(sat)

Vth Vge(off)
Vce-Vge

Ic-Vge for Expanders

MFCMU 1, HVSMU 1, Bias-T 1

MFCMU 1, HVSMU 1, Bias-T 1

MFCMU 1, Bias-T 1 or N1259A with

020

MFCMU 1

SMU 2

HCSMU 1 and SMU 1] or SMU 2

HCSMU 1 and SMU 1] or SMU 2

HCSMU 1 and SMU 1] or SMU 2

[
[
[
[

HCSMU 1 and SMU 1] or SMU 2

HCSMU 1, SMU 1

N1265A 1, MC/HCSMU 2, SMU 1

Cies (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
Coes (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
Cres (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
Cge (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
Cce (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
Cgc (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
Cies-Vge (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
Rg (N1272A) for IGBT MPSMU 1, HVSMU 1, MFCMU 1
ICES (N1272A) MPSMU 1, HVSMU 1

IGES (N1272A) MPSMU 1, HVSMU 1

Interconnection | Residual R B1505A, B1506A HCSMU 1 or SMU 1
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Application Library
Application Test Definitions

Category Test definition name Supported instrument Required equipment and quantity
MISCAP BV B1505A, B1506A SMU 1
C(MISCAP) MFCMU 1
Ileak-V SMU 1
PowerBIT Ic-Vcbo B1505A, B1506A SMU 1
Ic-Vce(PowerBIT) [HCSMU 1 and SMU 1] or
SMU/HCSMU 2
Ic-Vceo SMU 1
Ic-Vees SMU 2
Ie-Vebo SMU 1
Vce(sat)-Ic [HCSMU 1 and SMU 1] or
SMU/HCSMU 2
G-Plot for Expanders N1265A 1, MC/HCSMU 2, SMU 1
Ic-Ib for Expanders N1265A 1, MC/HCSMU 2, SMU 1
PowerDiode Cj-Vr B1505A, B1506A MFCMU 1, HVSMU 1, Bias-T 1
If-Vf HCSMU 1 or SMU 1
Ir-Vr SMU 1
Vf HCSMU 1 or SMU 1
CT (N1272A) MPSMU 1, HVSMU 1, MFCMU 1
IR (N1272A) MPSMU 1, HVSMU 1
GateCharge Qg(High Id Switching) B1505A, B1506A UHCU/HCSMU 1, MCSMU 2
Utilities Qg(High Vds Switching) MCSMU 1, HVSMU 1
Qg(High Ic Switching) UHCU/HCSMU 1, MCSMU 2
Qg(High Vce Switching) MCSMU 2, HVSMU 1
NI1272A N1272ACheckBreakdown?® BI1505A, BIS06A N1272A, MPSMU 1, HVSMU 1
IV Path (N1272A) NI1272A
N1274A IV Path (N1274A) B1505A N1274A
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Application Library
Application Test Definitions

Category Test definition name Supported instrument Required equipment and quantity
Thermal N1265A WaitTemperature B1505A, B1506A ThermoStream
ThermoStream ThermoStream
ControlTemperature
ThermoStream DefineParameters ThermoStream
ThermoStream FlowOff ThermoStream
ThermoStream Initialize ThermoStream
ThermoStream ReadTemperature ThermoStream
ThermoStream WaitReady ThermoStream
ThermoStream WaitTemperature ThermoStream
ThermalPlate Initialize Thermal Plate
ThermalPlate DefineParabeters Thermal Plate
Thermal ThermalPlate B1505A, B1506A Thermal Plate
ControlTemperature
ThermalPlate WaitTemperature Thermal Plate
ThermalPlate ReadTemperature Thermal Plate
MultiHVSMU | Switch HVSMU Output Mode B1505A HVSMU
Advanced FERAM Hysteresis B1500A WGFMU 1, RSU 2
(ni;’i"t'est FERAM PUND WGFMU 1, RSU 2
definitions of | FERAM Endurance WGFMU 1, RSU 2
Utility (NVM)) | ReRAM IV-Butterfly SMU 2 (3 for current limit control
option), WGFMU 1, RSU 2, GNDU
ReRAM FORM WGFMU 1, RSU 2, SMU 1 (Optional)
ReRAM Set ResetV-Loop WGFMU 1, RSU 2, SMU 1 (Optional)
ReRAM Reset SetV-Loop WGFMU 1, RSU 2, SMU 1 (Optional)
ReRAM Reset-Set WGFMU 1, RSU 2, SMU 1 (Optional)
ReRAM Endurance WGFMU 1, RSU 2, SMU 1 (Optional)
PCRAM Reset-Set WGFMU 1, RSU 2, SPGU 1
PCRAM ResetV-Loop WGFMU 1, RSU 2, SPGU 1
PCRAM SetV-Loop WGFMU 1, RSU 2, SPGU 1
PCRAM Endurance WGFMU 1, RSU 2, SPGU 1
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Application Library
Application Test Definitions

Category

Test definition name

Supported instrument

Required equipment and quantity

Utility (NVM)?

FERAM Psw Qsw Graph

FERAM PUND Stress

FERAM PUND Sub

ReRAM RESET Graph

ReRAM_Endurance Sub

ReRAM_Reset_Set Endurance
Sub

ReRAM_Reset_Set_Sub

PCRAM_Reset-Set_Sub

PCRAM Reset-Set endurance sub
(=SetV loop)

PCRAM_Reset-Set Loop-Sub

PCRAM_Rm_Sub

WGFMU Pattern Editor NoRead

B1500A

WGFMU 1, RSU 2

WGFMU 1, RSU 2

WGFMU 1, RSU 2

WGFMU 1, RSU 2, SMU 1 (Optional)

WGFMU 1, RSU 2, SMU 1 (Optional)

WGFMU 1, RSU 2, SMU 1 (Optional)

WGFMU 1, RSU 2, SMU 1 (Optional)

WGFMU 1, RSU 2, SPGU 1

WGFMU 1,RSU 2, SPGU 1

WGFMU 1, RSU 2, SPGU 1

WGFMU 1, RSU 2, SPGU 1

WGFMU 1, RSU 2, SMU 1 (Optional)

Thyristor Ia-Vak (PULSE) BI1505A, BISO6A HCSMU/UHCU/HVMCU,
HP/HR/MPSMU

Ta-Vak SMU 2

Thyristor IGT,VGT _la-Ig B1505A, B1506A SMU 2
IH_Ia-Vak SMU 2
IH_ Va-lak SMU 2
IL_Va-lak SMU 2
Off Ia-Vak (PULSE) HVMCU, HP/HR/MPSMU
Off Ia-Vak HVSMU, HP/HR/MPSMU
R_Ia-Vak (PULSE) HVMCU, HP/HR/MPSMU
R_Ia-Vak HVSMU, HP/HR/MPSMU

VGD,IGD _Ta-Vgk (PULSE)

VGD,IGD la-Vgk

TM_Ia-Vak

HVSMU/HVMCU, HP/HR/MPSMU

HVSMU, HP/HR/MPSMU

HCSMU, HP/HR/MPSMU
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Application Library
Application Test Definitions

Category Test definition name Supported instrument Required equipment and quantity
See Note 1 Cds B1505A, B1506A MFCMU 1, HVSMU 1, Bias-T 1
Cgd MFCMU 1, HVSMU 1, Bias-T 1
Cgs MFCMU 1, Bias-T 1 or N1259A with
020
Cgs-Vgs MFCMU 1
1d(off)-Vds SMU 2
1d-Vds [HCSMU 1 and SMU 1] or SMU 2
1d-Vgs [HCSMU 1 and SMU 1] or SMU 2
Rds-1d [HCSMU 1 and SMU 1] or SMU 2
Vth Vgs(off) [HCSMU 1 and SMU 1] or
SMU/HCSMU 2
See Note 2 TDDB Constant V B1505A, B1506A SMU 1
See Note 3 Qg(High Ic + High Vce + B1505A, BIS06A UHCU/HCSMU 1, MCSMU 2,
(needs test JESD24-2) HVSMU 1
definitions of 0 R T gad High Ic + High Vee + UHCU/HCSMU 1, MCSMU 2,
GateCharge | ypgpng.) HVSMU 1
Utilities)
Qg(High Ic + High Vce) UHCU/HCSMU 1, MCSMU 2,
HVSMU 1
Qg(R Load High Ic + High Vce) UHCU/HCSMU 1, MCSMU 2,
HVSMU 1
Qg(High Ic + JESD24-2) UHCU/HCSMU 1, MCSMU 2
Qg(R Load High Ic + JESD24-2) UHCU/HCSMU 1, MCSMU 2
Qg(High Ic) UHCU/HCSMU 1, MCSMU 2
Qg(R Load High Ic) UHCU/HCSMU 1, MCSMU 2
Qg(High Vce + JESD24-2) MCSMU 2, HVSMU 1
Qg(High Vce) MCSMU 2, HVSMU 1
Qg(JESD24-2 High Ic +
JESD24-2 High Vce)
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Application Test Definitions

definitions of
GateCharge
Utilities)

Qg(R Load High Id + High Vds +
JESD24-2)

Qg(High Id + High Vds)

Qg(R Load High Id + High Vds)

Qg(High Id + JESD24-2)

Qg(R Load High Id + JESD24-2)

Qg(High I1d)

Qg(R Load High Id)

Qg(High Vds + JESD24-2)

Qg(High Vds)

Qg(JESD24-2 High Id +
JESD24-2 High Vds)

Category Test definition name Supported instrument Required equipment and quantity
See Note 4 Qg(High Id + High Vds + B1505A, BIS06A UHCU/HCSMU 1, MCSMU 2,
(needs test JESD24-2) HVSMU 1

UHCU/HCSMU 1, MCSMU 2,
HVSMU 1

UHCU/HCSMU 1, MCSMU 2,
HVSMU 1

UHCU/HCSMU 1, MCSMU 2,
HVSMU 1

UHCU/HCSMU 1, MCSMU 2

UHCU/HCSMU 1, MCSMU 2

UHCU/HCSMU 1, MCSMU 2

UHCU/HCSMU 1, MCSMU 2

MCSMU 1, HVSMU 1

MCSMU 1, HVSMU 1

a. This test definiti